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Chapter 1. Introduction

About Power*Architect

Power* Architect from SQL Power Group is a visual data modeling tool designed for data architects,
DBAs, analysts, designers, and other professionals. Quickly design every aspect of your data model using
diagrams and a hierarchical view of your model structure. Y our datamodel remains platform-independent,
allowing you to maintain a single database schema that works well with multiple database platforms.

Power* Architect is also well-suited to data warehouse and data mart design. You can open multiple
source databases concurrently, then drag and drop objects (such as schemas, tables, and columns) into
Power* Architect's data modeling playpen to create a new model. After fine-tuning the data model in the
playpen, you can forward engineer the data model into new database on platforms such as Oracle, SQL
Server, DB2, PostgreSQL, or MySQL. Power* Architect also creates ETL (Extract, Transform, Load)
procedures you can use with Pentaho's popular open source Kettle ETL tool to populate the new database.

Power* Architect provides you with a variety of tools to view and compare data structures and mappings.
For example, you can compare the structure of any two databases, highlighting the differences and
similarities and generating the required DDL statements to synchronize them. You can also create a
visua mapping report listing the source tables used in your data model, or create an easy-to-read profile
summarizing the data contained in a database.

Whether you're building or maintaining a data model, Power* Architect provides the tools to help you
design your model in afraction of the time.

About This Guide

The Power* Architect User Guide provides step-by-step instructionsfor using Power* Architect and covers
all of Power* Architect's features and capabilities.

The guide assumes you are familiar with basic database operations and terminology (please refer to
Chapter 13, Glossary for alist of some common database terms). If you plan to use Kettle jobs, the guide
assumes you have some knowledge about ETL (Extract, Transform, Load) procedures. If you are looking
for more information about ETL, two books you may want to try are Building the Data Warehouse by
W. H. Inmon and The Data Warehouse Toolkit: The Complete Dimensional Modeling by Ralph Kimball
and Margy Ross.

Power*Architect Licensing and Distribution

Power* Architect is free and open source software, meaning that the source code is readily available.
Everyone is free to inspect, comment on, and modify Power* Architect's source code. Anyone who
modifies the program code is invited (but not required) to contribute their changes back to the project.
All contributions are subject to review and acceptance by the Power* Architect team. We always welcome
suggestions from Power* Architect users, in the spirit of making the application easier to use and providing
the features that matter the most to you.

Power* Architect isdistributed to the public under the GNU Public LicenseVersion 3. A copy of thelicense
isavailablein the section called “ Appendix A: GNU GPL Version 3" of this User Guide.




Chapter 2. Getting Started

To get started using Power*Architect, begin by reading the section called “Understanding the
Power* Architect User Interface” . Thissection givesyou aquick introduction to the main Power* Architect
areas, the playpen and the database tree. Y ou may then want to work through the hands-on the section
called “Example - Creating a DataModel” . This example shows you how to create a simple data model,
set up a database connection, and forward engineer your model to any database you choose.

Power* Architect contains many features, and you may choose to use some or al of these features
depending on what you are trying to accomplish. Please see the following sections for an overview of
typical activities you would perform with Power* Architect.

the section called “ About Data Models”

the section called “ About Data Structure Analysis’
the section called “Copying and Transforming Data’
the section called “ About Advanced Features”

the section called “ About System Preferences’

About Data Models

Asagenera guideline, you would typically follow these steps to create and use a data mode!:

1. Create adatamodel using the playpen. Y ou can do this by creating a data model from scratch, reverse

engineering an existing database, or by using a combination of these two methods.
For more information, see:

» Chapter 3, Creating a relational Data Model

» Chapter 7, Reverse Engineering a Data Model

Forward engineer your data model to create the data structure in a new database. To use forward
engineering, you must first set up a database type and connection for the target database.

For more information, see:

» Chapter 8, Forward Engineering a Data Model

» Chapter 5, Setting up Database Support

Use aKettle job to copy data into your new database.
For more information, see:

* the section called “Using Kettle Jobs’

About Data Structure Analysis

You can use Power* Architect's many data structure analysis features to view information about a data
model or database. Y ou can:




Getting Started

» Compare two data models to view the differences and similarities. Generate and run a SQL script to
update an older database to match a newer data model.

For more information, see:
* the section called “ Comparing Data Models’
» View aprofile of the datain a database table.
For more information, see:
« the section called “Profiling Data”
» Create areport listing the source tables used for the tablesin your Power* Architect data model.
For more information, see:
* the section called “ Creating a Visual Mapping Report”

 Export the source-to-target column mappings between a source database and your Power* Architect data
model.

For more information, see:

« the section called “ Exporting Column Mappings’

Copying and Transforming Data

Power* Architect provides two methods (one basic, one complex) for copying data between databases.
Y ou can:

» Copy data across database platformsto create a verbatim copy of an existing database.
For more information, see;
« the section called “ Copying Data Across Database Platforms’

* Create multiple transformations based on a data model.
For more information, see:

« the section called “Using Kettle Jobs’

About Advanced Features

Power* Architect contains a general-purpose SQL query tool that that allows you to work at the raw SQL
command level. This feature is meant as a convenience for advanced users. It is not necessary to use this
tool during routine data modeling, profiling, or database comparison activity.

For more information, see:

» Chapter 11, Universal SQL Access

About System Preferences

Y ou can set project and user preferences for Power* Architect.
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For more information, see:

 Chapter 6, Setting Preferences

Understanding the Power*Architect User
Interface

Each datamodel you createin Power* Architect is saved asaseparate project. When you open aproject, the
datamodel information is shown in Power* Architect's two main areas: the database tree and the playpen.

File & Edit Tools Advanced Tools - Forward Engineering, Compare Data Models, Auto Layout, Profile Tables

Company - Power*Architect

Eie Biit_Connections ETL Tools Profile Window Help
Q=B & 9 e¢|l=S B a
[a9)

TojEC
¢ invoice (TABLE)
# Columns folder of invaice
[ invoice_number INTEGER(10)
£ invoice_date: DATE(10)
| customer_name: VARCHAR (50)
[ customer_sddress: VARCHAR{50)
- Exported Keys falder of invaice
o= 14 invaice_invaice_line_tk
Imported Keys folder of invoice invaice
- Indiges folder of invoice imvoice_number INTEGER(ID)

B3
o L2 imvoice ok =)
¢ [ invoice_tine (TABLE) invoice_date: DATE(0)

& Columns folder of invaice_line custamer_name: VARCHAR(S0)

Exported Keys folder of invoice_line customer_address: VARCHAR(ED)
o Imported Keys folder of invoice_line
= Indices folder of invoice_line

£y

2

2 |||~ Playpen Zoom Tools
g

e

I— Playpen Object Tools

- (Create/modify/delete
IryolceRline] = tables, columns, indices,
invoice_line_id: INTEGER(10) [73 and relationships )
line_number: INTEGER(0) ’
linvoice_nutnber INTEGER(1D) 3
litem: VARCHAR(10)
cuantity. INTEGER(10) o
lptice: INTEGER(1 1)

]

- |

Database Tree Playpen

About the Database Tree

The database tree contains a hierarchical view of your project. The hierarchy includes:
» Theaobjectsin your data model (tables, columns, keys, indices, etc.).
» The database connections you've added to the project.

» Any objects you've obtained through reverse engineering an existing database. You can drag these
objectsinto the playpento add them to the datamodel you're buildingin Power* Architect. (Large objects
may take some time to load in the playpen.)

You can expand the branches in the tree to view objects and can often right-click an object to perform
actions. The following icons are used in the database tree to identify the object type.

@ Database

[@ Catalogue

@8 Schema
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;@ Owner
| Table
| column
Primary Key
£ Exported Key
Imported Key

El Index

[--] Unique Index

About the Playpen

The playpen is your main work area in Power* Architect, where you create and modify your data model.
You can use the playpen to experiment and manipulate tables and relationships. Y our changes are not
saved until you decide to save them.

Your data model can includes tables, columns, indices, and relationships. You can create these objects
in Power* Architect or obtain them by reverse engineering an existing database. For more information on
working in the playpen, see Chapter 3, Creating a relational Data Modd .

Using Power*Architect on Different Operating Systems

Power* Architect supports multiple operating systems, such as Windows, Macintosh and Linux.
Power* Architect works the same on al operating systems, with afew minor exceptions:

» On Windows and Linux, CTRL is used as the accelerator key. On Macintosh, CMD is the accelerator
key.

* On Windows and Linux, the Power* Architect menu bar is shown below the Power* Architect title bar.
On Macintosh, the menu bar is shown at the top of the Power* Architect window.

Example - Creating a Data Model

This section will show you how to set up a simple database "from scratch”, just to get you started using
the tools, without modifying any live data. If you follow the example literally, you will create a trivial
"customer and orders database”.

Important; You must create the target database needed in this example. You can use standard vendor-
specific database tools to create the database.

Setting Up Databases

1. Setup Driver. Select File->User Preferences if you are using Windows and Architect->Preferences if
you are using Macintosh. Then select the JDBC Drivers tab. Select the database connection type you
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wish to use from the list on the l€ft. If thereis already a driver for the connection type you wish to use,
click OK and go on to the next step. Otherwise, click the Add JAR button, navigate to where you have
the driver Jar fileinstalled, and click OK.

. Create a Connection. In the Database Tree section of the main window, right click and choose Add

Source Connection->New Connection. For this example you can use a name like SampleDB for the
Connection Name. Then select a data type you wish to use, which should be the driver you set before.
Then fill the hostname, port, database, fileif asked. The JDBC URL will automatically generate when
you fill those blanks, so you don't have to type it an extra time. Fill in the Username and password
(which is set on the server machine).

Designing a Database

Y ou are now ready to design some tables. For this example, we will create the Customer and Orderstable
shown here.

1.

Click the New Tableicon at the right side. The cursor will change to a crosshair. Move the cursor near
the | eft of the Playpen area, and click. A "New Table" will appear.

. Also, the Table Properties Dialog will appear. Rename thistable to Customers.

. Click the Insert Column icon, and a column property window will appear for the new column. Rename

the column to customer_id and make it part of the primary key.

- Insert additional columnsfor Firstname, Lastname, Address, City, Province, Country Code ! and Postal

Code. The table should look something like the following;:

066 New Project - Power*Architect

 BEEEBOERDEEE
v [® PlayPen Database

b | Customers (TABLE)
» (@ SampleDB

Customers
customer_id: INTEGER(10) [PK]

firstname: VARCHAR(40)
lastname: VARCHAR(40)
city: VARCHAR(40)
province: VARCHAR(40)
countrycode: CHAR(2)
postcode: VARCHAR(10)

SECINE A EEE R

Q

saL

EN

Create a second table, and name it Orders.

Create columns named order_id (in the primary key), Quantity, Total Amount, and customer_id. Y our
project should now look something like the following:

8eoe New Project - Power*Architect

EEEERCEEEIFIE

A Eé) PlayPen Database
» || customers (TABLE)

S
N

» || orders (TABLE) custamers
v (@ SampleDB customer_id: int4 [PK]

» @ yefel - orders
firstname: varchar(40} order_id: int4 [ PK |
lastname: varchar(40)
city: varchar(40) quantity: int4 =
province: varchar(40) total_amount: int4
countrycode: bpchar(2) customer_id: int4 =
postcode: varchar(10) 5

saL
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7. We need a relationship between these tables. An order should have a foreign key that refers to the
customer. Click the "New Non-ldentifying Relationship" icon. Select the Customers table, then the
Orders table, and a link will be drawn as shown. Click this link and the keys that take part in the
relationship will be highlighted in red.

ene New Project - Power*Architect

EEEEEICFEEIFE

¥ [® PlayPen Database 1,
P || customers (TABLE) i

» || orders (TABLE) customers i

v (@ SampleDB customer_id: int4 [PK ] ]
> fi |

@ yefei firstname: varchar(40) orders ﬁ
lastname: varchar(40) (1 P =

city: varchar(40) L_ order.id: inté [ PK] é

pravince: varchar(40) quantity: int4 ]

countrycode: bpchar(2) total_amount: int4 =

postcode: varchar(10) customer_id: int4 [FK]

saLl : i
%

Forward Engineer

1. If you're happy with the database layout (you can always changeit later), it'stimeto create the database.
Click on the Forward Engineer button. Y ou should see awindow similar to the following:

806 Forward Engineer SQL Script
Create in: SampleDB ] :,] _fmx.
Generate DDL for Database Type: | PostgreSQL in }
(no catalog)
Schema public|

(Cancelj ( OK )
4

2. Set the"Createin" database to be the source connection we defined earlier. Set the database type to be
the type that was set in the user preferences. Fill in the remaining fiel ds based on the database type that
was selected and press ok. Y ou should see awindow similar to:
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806 Preview S0L Script

Your Target Database is SampleDB

CREATE TABLE public.customers
customer_id INTEGER NOT NULL,
firstname VARCHAR(40) NOT NULL,
lastname VARCHAR(40) NOT NULL,
city VARCHAR(40) NOT NULL,
province VARCHAR(40) NOT NULL,
countrycode CHAR(2) NOT NULL,
postcode VARCHAR(1O) NOT NULL,
CONSTRAINT customers_pk PRIMARY

KEY (customer_id)

%

CREATE TABLE public.orders [
order_id INTEGER NOT NULL,
guantity INTECER NOT NULL,
total_amount INTEGER NOT NULL,
customer_id INTEGER NOT NULL,
CONSTRAINT orders_pk PRIMARY KEY

(order_id)

%

ALTER TABLE public.orders ADD CONSTRAINT
customers_orders_fk

FOREICN KEY (customer_id)

REFEREMNCES public.customers (customer_id)
ON DELETE NO ACTION

ON UPDATE NO ACTION

NOT DEFERRABLE;

( Copy j {-E:nuevcui:«eaI ( Save j ( Close j

A

3. If this looks plausible, click Execute, and the tables and their relationship will be created.
Congratulations! Y ou have now created a simple database using the visual toolsin Power* Architect.

Comparing Data Models

Suppose that after using this database, you realize that there should be a "shipping amount" field in the
Order table (we never promised this would be completely realistic example).

1. Select the Order table by clicking on itstitle.

2. Click the Insert Column field and, as before, rename the New Column, this time to Shipping_Amount.
Change its type to Decimal with precision 10 and scale 2.
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3. Now we need to comparetwo different DataModels, the original database and the current project. Click
the Compare DM icon. Set the "Older" to Physical Database SampleDB (you may need to change the
Schemato Public). Set the "Newer" to "Current Project” (since it is now newer than the database you

created in Step 6). Set the output format to SQL.

PS: swap button can help you easily swap the newer the the older.

806 Compare Data Models

Compare Older

() Current Project [New Project]

B Physical Database database schema

['sampleDB %) [yefei %) [public ) New.. )

() From File:

Choose...
With Newer
& Current Project [New Project]
() Physical Database database schema
SampleDB - yefei o public o New...
() From File:
Choose...
Output Format
@ 5SQL for  PostgreSQL |¢] to make Older look like Newer
() English descriptions
_ Suppress similarities
Status.
Swap { Cancel )

4. Click Start. You should see the SQL Preview window again, but this time with just an ADD for the

column you just added:

8en0e Compare DM

Cenerated SQL Script to turn SampleDB.yefei.public into New Project (Database Connections.PlayPen Database)
Your Target Database is SampleDB

ALTER TABLE yefei.public.orders ADD COLUMN shipping_amount DATE NOT NULL;

( Copy :J (Execute) ( Save ) ( Close )

5. Click Execute, and the new column will be added to your database table.
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When you exit the program, it will ask to save your project. Since you might want to alter thisin future,

to experiment with some of the other tools without damaging any live data, you may wish to save the
Project file.

The remainder of this document provides a more comprehensive explanation of the various functions that
Power* Architect offers.

10



Chapter 3. Creating a relational Data

Model

Use the Power* Architect playpen to create a data model diagram that includes tables, columns, indices,
and relationships. Before you begin, be sure to read Chapter 2, Getting Started , which explains how to

use the playpen and the database tree.

When you create a data model in Power* Architect, the model is saved in its own project. The project
contains the datamodel diagram in the playpen and the database tree. Y ou can have multiple projects (and
therefore multiple datamodel s) openin Power* Architect at once. Each project opensin aseparate window.

Working with Tables

Creating New Tables

To create anew table:

1.

Click "= in the side toolbar. The cursor changesto a +.
Note: To cancel creating a new table, press ESC.
Alternate methods:

* Right-click in the playpen, then click New Table.

 Place the cursor over the playpen, then press T.

2. Click in the playpen where you want to create the table. The Table Properties dialog box appears.

8enNne Table Properties

Table Name |
Primary Key Name

Remarks

Table Colour [ e

Text Colour

:

Dashed Lines

Rounded Corners [

(" Cancel ) f—ﬁK—}

4

3. Enter the following information:

Table Name Enter atable name.

Primary Key Name

You cannot enter a primary key name until you
have added columns to the table and defined the
primary key. The primary key name is used when
you forward engineer the data model. For more

11




Creating arelational Data Model

In thisfield ... Do this...

information, see the section called “ Creating New
Columns’ .

Note: Primary key names are not used when
forward engineering to a MySQL database
(MySQL does not support custom primary key
names).

Remarks Enter adescription of thetable. When you forward
engineer the data model, the remarks will be
included as comments in the database.

4. Click OK.

Modifying Tables

To modify atable:

Click atablein the playpen, then click 1&3 in the side toolbar.

The Table Properties dialog box appears.
8ens Table Properties

Table Name Customers

Primary Key Name Customers_pk

Remarks sample table

(cancel ) € oK )
A

Alternate methods:
» Right-click atable in the playpen, then click Table Properties.
 Click atablein the playpen, then press Enter.

» Modify the table properties as required. For a description of the properties, see the section called
“Creating New Tables’ .

» Click OK.

Copying Tables from external documents

To copy tables from external documents (for example spreadsheets) into Power* Architect you can select
& copy the table names from your external documents and paste (CTRL + V) them into the Playpen.

Working with Columns

Creating New Columns

When you create a column, you can choose where the new column isinserted in the table.

12




Creating arelational Data Model

To add acolumn to atable;

1. Click atable in the playpen. The location you click determines where the column will be inserted in
the table.

« If you click the table name or if the table does not contain any columns, the new column is added
to the end of the column list.

* If you click an existing column, the new column is added above the selected column.

" Click -«a-?} in the side toolbar. The Column Properties dialog box appears.
® 76O  Column Properties of New_Caolumn

Source for ETL Mapping
None Specified

Mame
New_Column

Type

"INTEGER 4+

Precision _ Scale .
10 . 0.

[ In Primary Key
[ Allows Nulls
[ Auto Increment

Sequence Mame (Only applies to target platforms that use sequences)
Customers_New_Column_seq

Remarks

Default Value

Ii Cancel :,I (——BI(—;

4
Alternate methods:
» Right-click atable, then click New Column.
» Click atable, then press C.
3. You can enter the following information:
Name Enter the column name.
Type Select the type of data the column holds.

13



Creating arelational Data Model

4.

Modifying Columns

To modify a column:

1

Inthisfield ... Dothis...

Precision Set the data precision.

Scale Set the scale.

In Primary Key Select the check box if the columnisinthe primary
key.

Allows Nulls Select the check box if the column handles null

information.

Auto Increment

Select the check box if auto increment is allowed.

Seguence Name

When Power*Architect creates a table in a
database platform that uses sequences (such as
Oracle or PostgreSQL), Power* Architect creates
a sequence for each auto-increment column in the
table. Enter the name to use for the sequence.

Note: This option is only available if you have
selected the Auto | ncrement option for the column.

Remarks

Enter comments about the column. When you
forward engineer the data model, the remarks will
be included as comments in the database.

Default Value

Enter adefault value for the column.

Note: Power* Architect does not validate the
default value, so ensure you use a valid format.
The following examples show valid formats for
different datatypes:

* ‘word' for a String
» {d'2007-12-10% for aDate
« {t'5:38:00% foraTime

» {ts'2007-12-10 5:38:00'} for a Timestamp

Click OK.

Click acolumn, then click @ in the side toolbar.

Alternate methods:

* Right-click a column, then click Column Properties.

* Click acolumn, then pressENTER.

The Column Properties dialog box appears.
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8N Column Properties of customer_id

Source for ETL Mapping
None Specified

Name

customer_id

Type
"INTEGER k9
Precision Scale
) )
10 5 0

™ In Primary Key
| Allows MNulls
[ Auto Increment

Sequence Mame (Only applies to target platforms that use sequences)
Customers_customer_id_seq

Remarks

Default Value

( Cancel ) G—OI(—)

P

If you added this column to your data model using reverse engineering, the source database and table
from which the column originated are shown at the top of the Column Properties dialog box.

2. For modifying multiple columns at a same time: select multiple columns, then open column properties
as above. The window looked like this:

15
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88 Edit multiple column properties

Source for ETL Mapping
MNone Specified

Name
i~
W | INTEGER B
Precision . Scale —
W 0. ™ 0.

™ 1 In Primary Key
™ ) Allows Nulls
™ ] Auto Increment
Sequence Name (Only applies to target platforms that use sequences)

Remar ks

4

Default Value

v

( Cancel ) €0k

4

Y ou can modify the properties of every column you selected by checking the checkboxes in front of
them.

3. Modify the column properties as required. For a description of the properties, see the section called
“Creating New Columns” .

4. Click OK.

Moving Columns

Y ou can move a column from one table to another or rearrange columns within atable.
» To move acolumn, click the column and drag it to a new location.
e To move multiple columns, use CTRL+click to select the columns, then drag them to a new location.

Note: You can aso add or remove columns from the primary key. For more information, see the section
called “Working with Primary Keys’ .

You can also use cut and paste to move to a column from one table to another. The column keeps the
source for ETL mapping from the original table.

Copy Columns from external documents

To copy column from external documents (for example spreadsheets) into Power* Architect:

16
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1. Select & copy the columns from your external document
2. Select the table in the Playpen you want to add the column to

3. PressCTRL + V to copy the columnsinto the table

Working with Primary Keys

After adding one or more columns to atable, you can define the column(s) used for the primary key.
To add aprimary key:
1. Select one or more columns.

2. Drag the column(s) to the primary key areain the table.

Orders
Order_Mumber: INTEGER(10) [PK

lolgs s [Orders.Customer_Number]
Order_SalesTax: INTEGER{10)
Order_Amount: INTEGER(10)
Customer_Mumber: INTEGER({10)

To remove aprimary key:
1. Select the column(s) in the primary key area.
2. Drag the column(s) from the primary key areato the table's column list.

Note: Y ou can change the primary key name for the table. For more information, see the section called
“Modifying Tables” .

Working with Relationships
About Identifying and Non-ldentifying Relationships

You can create relationships between tables. For example, a typical one-to-many relationship might
describe how invoices and invoice line items rel ate to each other. The relationship might indicate that the
invoice linetableisachild of theinvoice table, and every row intheinvoice line table relates to exactly
onerow in theinvoice table.

Y ou can create identifying and non-identifying relationships:
* Inan identifying relationship, the child table cannot be uniquely identified without the parent.
* Inanon-identifying relationship, the child can be identified independently of the parent.

Y ou could choose to create the invoice and invoice line relationship from the previous example as either
an identifying or non-identifying relationship.

« If you create an identifying relationship, an invoice line cannot be uniquely identified without also
knowing the invoice number it belongs to. For example, assume that invoice line numbers aways start
at 0 or 1 within each invoice. The same line numbers will appear in different invoices - each invoice
will havealine0, line 1, line 2, etc.

17
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invoice invoice_line

invoice_number: INTEGER(10) [PK] line_number: INTEGER(10) [ PK]

- - | -{invoice_number: INTECER(10) [ PFK]
invoice_date: DATE(10) T U

customer_name: VARCHAR(10)

item: VARCHAR(10)
customer_address: VARCHAR(10)}

guantity: INTEGER(10)
price: INTECER(10)

* If you create a non-identifying relationship, an invoice can be uniquely identified without knowing
the invoice number it belongs to. For example, assume each invoice line has its own unique identifier
(invoice_line_id). In this example, invoice line id isreferred to as a "surrogate key," because it's just
amade-up number which has no special meaning in terms of the invoice line.

) ) invoice_line
[Ledisio- invoice_line_id: INTEGER(10) [PK]
invoice_number: INTEGER({10) [ PK] i ber: INTEGER(10)
— __gline_number:

invoice_date: DATE(10) invoice_number: INTEGER(10) [FK]
customer_name: VARCHAR(10) item: VARCHAR(10)
customer_address: VARCHAR(10) quantity: INTEGER(10)

price: INTEGER(10)

For this relationship, you would also want to create a unique index on the combination of
(invoice_number, line_number) to guarantee there are no two line items with the same line number on
the same invoice. In the identifying relationship example, the primary key enforces thisrule.

Creating Relationships

To create anew relationship:

1. Do one of the following:

To define an identifying relationship, click Tx in the side toolbar, or press R. The cursor changes
toa+.

To define anon-identifying relationship, click i+ in the sidetoolbar, or press SHIFT+R. The cursor
changestoa+.

Note: To cancel creating arelationship, press ESC or click ablank areain the playpen.

. Click the parent table, then click the child table. A relationship is created between the two tables and
isshown asaline.

invoice_line
invoice

invoice_line_id: INTEGER{10) [ PK]
invoice_number: INTECER(10) [PK]

- - _ line_number: INTEGER(10}
invoice_date: DATE(10) invoice_number: INTEGER(10) [FK]
customer_name: VARCHAR(10)

item: VARCHAR(10)
customer_address: VARCHAR(10) quantity: INTEGER(10)
price: INTECER(10)

The mapping between the tables is based on the parent table's primary key. For each column in the
primary key of the parent table:

« If the child table contains a column with the same name and thisis the first relationship between the
two tables, the relationship is mapped to the existing column in the child table.

Parent Child
id: INTEGER(10) [PK] ~ -gjGeneric_key: INTEGER(10) [PK]

id: INTEGER(10) [ FK ]

Ceneric_Column: INTEGER{10)|

18
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« [f the child table does not contain a column with the same name, or the child table contains acolumn
that has the same name but the column has a different data type, or a relationship already exists
between the tables, a new column is created in the child table. The relationship is mapped to the

new column.
Parent Child
id: INTEGER(10) [PK ] L _a|Generic_key: INTEGER(10) [PK]

id: VARCHAR(10) [PK]
Parent_id: INTEGER(10) [FK]

Ceneric_Column: INTEGER(10)

3. To view the columns that are mapped by the relationship, click the relationship link. The mapped
columns are shown in red.

You can now define the relationship properties, view the individual column mappings or change the
mapping of the child table to the parent table. For more information, see the section called “Modifying
aRelationship” .

Note: Y ou can automatically straighten the relationship lines between tables. For more information, see
the section called “ Straightening Diagram Lines in the Playpen” .

Modifying a Relationship

To modify arelationship:

1 2
Click arelationship link in the playpen, then click 1’) in the side toolbar. The Relationship Properties
dialog box appears.

8ene Relationship Properties

[ Relationship = Mappings -

Relationship Name invoice_invoice_line_fk
Relationship Type () Identifying
O] Non-Identifying

Cardinality PK Table: invoice FK Table: invoice_line
) Zero or More ® Zero or More
C One or More C One or More
C Zero or One C Zero or One

@ Exactly One

Deferrability  Not Deferrable
C Deferrable, Initially Deferred

—~ - .
) Deferrable, Initially Immediate

Update Rule ) Cascade Delete Rule () Cascade
O Restrict () Restrict
@ No Action @ No Action
) Set Null (O Set Null
: Set Default : Set Default
s
Alternate method:

* Right-click the relationship link, then click Relationship Properties.
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2. You can enter the following information on the Relationship tab:

Relationship Name

Enter a name for the relationship. When you
forward engineer the data model, the relationships
are created as foreign key constraints in the
target database. These constraints are named based
on the relationship name. You can aso view a
relationship's namein the playpen when you hover
over the relationship line.

Relationship Type Select the type of relationship (identifying or non-
identifying).

Cardinality Select the end cardindlity for the primary and
foreign keys.

Deferrability Select the deferrability options.

* Not Deferrable - Foreign key constraints are
checked immediately at the time an INSERT,
UPDATE, or DELETE statement is issued.

» Deferrable, Initially Deferred - If the database
transaction doesn't specify whether to defer
congtraint checks, the foreign key constraints
will be deferred, meaning that they are not
checked until the INSERT, UPDATE, or
DELETE transaction is committed.

» Deferrable, Initially Immediate - If the database
transaction doesn't specify whether to defer
constraint checks, foreign key constraints are
checked immediately at the time an INSERT,
UPDATE, or DELETE statement is issued.

Important: Before selecting an option, read
the following description to ensure you fully
understand the effect of each option.

When manipulating data in a database (using
INSERT, UPDATE, and DELETE statements),
the foreign key constraints created by
Power* Architect are used to ensure data integrity
between the two tables. The deferrability options
control when these constraints are enforced.

Within the context of a transaction, deferred
constraints are not checked until the transaction
is committed, while immediate constraints are
checked at the time the INSERT, UPDATE, or
DELETE statement is issued (in the middle of
the transaction). This means that if you are using
immediate constraints, you must be careful about
the order in which data is changed. With deferred
constraint checking, you can make changesin any
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order aslong as all constraints have been satisfied
by the time you commit.

For databases that support deferred and immediate
constraint checking, each transaction can specify
whether to defer constraint checks or carry
them out immediately. If a transaction does not
specify this option, each deferrable foreign key
constraint is evaluated according to its "initially
immediate” or "initially deferred” option. On the
other hand, constraints marked as "not deferrable”
will always be checked immediately regardless of
the transaction's setting.

Important Notes:

* For data manipulation done outside the context
of a database transaction, there is no difference
between immediate constraint checking and
deferred constraint checking.

* Not all database platforms support this
option. Some only support deferred constraint
checking, while others only support immediate.
When Power* Architect forward engineers to
these types of systems, the DDL script includes
comments warning about this lack of support.

Delete Rule

» Restrict - Prevents deletion of areferenced row.

* No Action - If any referencing rows still exist
when the constraint is checked, an error raised;
thisisthe default behavior if you do not specify
anything. (The essentia difference between two
choicesisthat No Action allows the check to be
deferred until later in the transaction, whereas
Restrict does not.)

» Casecade - When a referenced row is deleted,
row(s) referencing it should be automatically
deleted as well.

» Set Null - Cause the referencing columns to be
set to nulls when the referenced row is deleted.

» Set Default - Cause the referencing columns to
be set to default values when the referenced row
is deleted.

NOTE: Set Default and Set Nulls do not
excuse you from observing any constraints. For
example, if an action specifies Set Default but
the default value would not satisfy the foreign
key, the operation will fail.

Update Rule
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In thisfield ... Do this...

Analogous to Delete Rule there is also Update
Rule which is invoked when areferenced column
is changed (updated). The possible actions are the
same.

Platform Supports  Oracle- Supportsonly Restrict, No Actioninthe
Update Rules and everything except Set Default
inthe Delete Rules.

» PostgreSQL - Supports every rule.

e MySQL - Supports everything except Set
Default in both the Update and Delete Rules.

« IBM DB2 - Supportsonly Restrict, NoActionin
Update Rules and everything except Set Default
in Delete Rules.

» HSQLDB - Supports everything except Restrict
in both Update and Delete Rules.

* SQL Server 2000 - Supports only Casecade and
No Actionin both Update Rule and Delete Rule.

e SQL Server 2005 - Supports everything except
Restrict in both Update and Delete Rule.

3. On the Mappings tab, you can change the mapping to the child table. Click and drag the relationship
link to the column in the child table that is mapped to the parent table.

Note: If acolumninthe child table has [FK] besideit, this meansthe columnisaforeign key in another
parent table. This alerts you that the column is aready "in use", since you wouldn't normally use the
same column as aforeign key in multiple tables.
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8086

Relationship Properties

[ Relationship = Mappings ]

invoice invoice_line
invoice_number: INTEGER(10) [PK] invoice_line_id: INTEGER(10) [PK]
invoice_date: DATE(10}

line_number: INTEGER(10)}
customer_name: VARCHAR(50)

invoice_number: INTEGER(10) [FK]
customer_address: VARCHAR(50} item: VARCHAR(10)

quantity: INTEGER{10)
price: INTEGER(10)

%
(_Cancel )
ek

4

4. Click OK.

Working with Indices

Creating an Index

Y ou can create multiple indices for atable.

To create an index:

" Sdectatableinthe playpen, then click I:_el.’r inthesidetoolbar. The Index Propertiesdial og box appears.

23



Creating arelational Data Model

8ens Index Properties

Index Name invoice_idx

1

Unigue
Primary Key

[ Clustered

Index Type | Platform Default %)
In Index Calumn AscfDes
invoice_number: INTEG... A UNSPECIFIED
|invoice_date: DATE(10) | UNSPECIFIED

customer_name: VARC... | UNSPECIFIED
customer_address: VA... | UNSPECIFIED

ONE=

[ —

(Cancelj E OK )

4
Alternate methods:
 Left-click atablein the playpen, then press|.
» Right-click atable in the playpen, then click New Index.
* Right-click atable in the database tree, then click New Index.
2. You can enter the following information:
Index Name Enter aname for the index.
Unique Select the check box if the index will act as

a constraint which guarantees the values in this
index's columns are unique across al rows in the
table. Thisissimilar to the primary key constraint,
with two exceptions: A unique index may contain
nullable columns, and atable can have any number
of unique indices.

Primary Key
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Select the check box to set thisindex as the table's
primary key. The primary key is a specia type
of index which enforces uniqueness: The values
in the primary key's columns are unique across
al rows in the table. A table can only have one
primary key, and none of the columns in the
primary key may benullable. It is considered good
practiceto haveaprimary key on every tableinthe
data model.

Clustered

Select the check box to create a clustered index.
Many databases support the notion of a clustered
index. The exact meaning varies by platform, but
marking an index as clustered often affects the
physical ordering of the rows within the table
(which may increase or decrease performance
based on thetypesof SQL queriesbeing run). Most
database platforms alow only one clustered index
per table.

Index Type

Select the index type. The list includes al known
index types for al database types configured in
your user preferences. If you are building a cross-
platform data model, it's best to leave this setting
at "platform default." However, if you are tuning
your data model for a specific target database,
you may choose the desired index type for your
platform.

List of columns

Select the In Index check box beside each column
you want to include in theindex. For each column,
select the sort order (Ascending, Descending, or
Unspecified).

Use the arrows at the bottom of the dialog box
to set the order of the columns within the index.
Columns higher in the list will come first in the
index's column list.

Notes:

« If thetable contains columnsin the primary key,
a separate index will always be created for the
primary key column(s), even if you don't select
any columns.

* On some database platforms, the column order
in the index and the column order in the SQL
WHERE clause must match in order for the
guery optimizer to use the index.

e On most database platforms, a WHERE clause
that references a subset of a multi-column index
can usualy be used when those columns in the
WHERE clause are the leading columns in the
index.
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In thisfield ... Do this...

Example: Table A has columns B, C, D, E, F.
Table A hasan index on (F, E, D).

SELECT * FROM a WHERE f='x"; - index can
be used on most platforms

SELECT * FROM aWHERE e='x'; - index can
not be used on most platforms

SELECT * FROM a WHERE f="x' AND e='x'
AND d='X"; - index can be used

SELECT * FROM a WHERE d="x' AND e='x'
AND f='x' ; - index can be used on some
platforms, but index order and WHERE clause
order are different so some platforms will not
use the index

3. Click OK.

Modifying an Index

To modify an index:

1. Right-click atableinthe playpen, then click Index Properties. If there are multipleindicesfor thetable,
select the index you want to modify.

Alternate method:
* Right-click the index in the database tree, then click Index Properties.
The Index Properties dialog box appears.

2. Modify the index properties as required. For a description of the properties, see the section called
“Creating an Index” .

3. Click OK.

Deleting an Index

Right-click the index in the database tree, then click Delete Selected.

Working with Diagram Objects in the Playpen
Using Undo and Redo

Power* Architect keeps track of your actions and allows you to undo them at a later time. The 100 most
recent actions you have performed are remembered and can be undone in sequence.

If you undo an action accidentally, you can choose to redo the action. However, be careful: If you make
anew change after undoing one or more actions, your redo history islost.
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To undo an action, click &) in the top toolbar. Y ou can aso select Edit » Undo or press CTRL+Z.

To redo an action, click 2 in the top toolbar. Y ou can also select Edit » Redo or press CTRL+Y.

Selecting Multiple Objects in the Playpen

To select multiple objects (tables, columns, or relationships) in the playpen, do any of the following:
» PressCTRL or SHIFT and click the objects.

» Click ablank areain the playpen, then drag to form a grey box around the objects.

e Press CTRL+A to select al the objects in the playpen.

To cancel the selection, click ablank areain the playpen.

Deleting Diagram Objects in the Playpen

To delete a diagram object (table, column, or relationship) in the playpen, select one or more objectsin
the playpen, then click in the side toolbar.

Alternate methods:

 Right-click an object, then click Delete Selected.

* Select one or more objects, then press DELETE.

Rearranging Diagram Objects in the Playpen

Y ou can change the layout of your data model diagram by rearranging the tablesin the playpen. Y ou can
also change where relationship links visually connect to atable in the diagram. (To change the columns
mapped by a relationship link, you must modify the relationship. For more information, see the section
caled “Modifying a Relationship” .)

Notes:

* You can rearrange columns within a table or move columns from one table to another. For more
information, see the section called “Moving Columns” .

* You can automatically arrange the tables in the playpen. For more information, see the section called
“Automatically Arranging Tables in the Playpen” .

* You can automatically straighten the relationship lines between tables. For more information, see the
section called “ Straightening Diagram Lines in the Playpen” .

To move atable, select one or more tables, then drag the table(s) to a new location in the playpen.

To move the placement of a relationship link, select a relationship link, then drag either end of the link
to anew location on the parent or child table.

Automatically Arranging Tables in the Playpen

Y ou can automatically arrange tables in the playpen. Automatic layout works best when you have alarge
or medium-sized collection of tables, and may not work as well with a small number of tables.
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To automatically arrange tables, select several tables in the playpen, then click ET’ in the top toolbar.

Note: If you don't select any tables or select only one table, all of the tables will be arranged.

Straightening Diagram Lines in the Playpen

You can automatically create straight lines for the relationship links in your data model diagram. All
relationship links will be changed to horizontal or vertical straight lines, as long as the tables connected
by the link are aligned horizontally or verticaly. If the tables are not aligned, the relationship link will
not be changed.

To straighten the relationship lines, right-click ablank areain the playpen, then click Straighten Lines.

Using the Playpen Zoom Options

Y ou can use the zoom options on the side toolbar to control the magnification level in the playpen. The
four zoom buttons, in order from top to bottom, are:

&, Zoomin

= Zoom out

“':Ix Reset the zoom to the default level

ﬁJn Zoom to fit

To use the zoom options on specific objects in the playpen, select the objects before clicking a zoom
button. If you don't select any objects in the playpen, the zoom options affect the entire diagram.

Finding and Replacing Playpen Objects

You can search for objects in the playpen. You can then quickly rename the items or select them in the

playpen.

1. Select Edit » Find/Replace, or press CTRL+F. The Find dialog box appears.
808 Find
Look for

P
) Tables

P - "
) Relationships
'

L

Columns

Named

Comparing by @) substring () Exact Match () Regex

@ lgnoring case

f—&earch—) 4 Cancel y,

4
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2. Enter your search criteria, then click Search. The Search Results dialog box appears with your results.

8eNns Search Results
Type Mame Rename Selected
Column of Customers customer_id
Index$Column customer_id Show in Playpen
Column of Orders customer_id
Index$Column customer_id
( Cancel )
s S i

3. Torename an object, select the object and click Rename Selected. Y ou can also select multiple objects
if you want to rename all the objects using the same name.

4. To select an object in the playpen, select the object and click Show in Playpen.

You can aso find tables in amodel by selecting the table in the Playpen Database in the Database Tree

and clicking on 'Zoom to fit' ="%in the Playpen Zoom tools on the right side.

Printing or Exporting a Data Model Diagram

To print the data model diagram currently in the playpen, select File » Print.
To export the data model diagram currently in the playpen:

1. Select File » Export Playpen to PDF. The Save dialog box appears.

2. Select the location and filename for the PDF, then click Save.

3. To hide the Creating PDF dialog box, click Run in Background.
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Chapter 4. Creating a multidimensional
(OLAP) Data Model

Using the Power* Architect OL AP Schema Editor you can also create a multidimensional data model that
includes dimensions, cubes and measures.

E5 "FoodmartSchema - OLAP Schema Editor S | G |
IES FoodmartSchema E
o :ﬂ Store 2
o\ Store Size in SQFT
o\ Store Type \E Product )
o\ Time H [Froduct =
o= \g Product Product Family =
oI Sales Product Department Q
Product Categary G
Product Subcategory
Erand Name ®
Product Name
& caics \E Store Twpe Eid
[Pimensions lim
Store
Store Gize in SGFT i
Store Type a
[Time
Product
Framotion Media
Promotions
C s \p Store
Education Level Store
Gender
Marital Status E:g;z gg;igw %
[fearly Incame Stare City Q
\[@ Store Size in SAFT Measuras: Stare Marme
[Store Siza in SOFT Lnit Sales =%
Store Sqft Store Cost
Store Sales
Sales Count
Custormer Count

The development of the OLAP Schema Editor is still in an early stage so not al it's functionality is
implemented yet. We welcome you to try it out and give us your feedback. This part of the manual covers

only a small part of the functionality and is intended for users with experiences in building Mondrian
OLAP schemas.

Creating a new multidimensional Data Model

To create an OLAP schema select OLAP->Edit Schema->New Schema. Select the database your schema
will be based on and enter aname for the new schema. Thelist of database connections correspondsto the
databases availablein the DB Treein themain Architect frame. If you'd liketo base your OLAP schemaon
an existing database, simply connect to that database in the DB Tree before creating your OLAP schema.

Now you can easily add cubes, measures and dimensions to your schema by clicking on the according

icon on the right side. The cursor will change to a crosshair. Move the cursor near the |eft of the Playpen
area, and click. The properties box will appear.

Adding a Cube

To add a cube:

1
Click on q to create anew cube. Y ou can also press "'c" instead.

2. The cursor will change to a crosshair. Move the cursor near the | eft of the Playpen area, and click. The
Cube Properties box will appear.
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3. Enter the following information;

Inthisfield ... Dothis...

Name Enter a measure name.

Caption Enter the measure caption.

Default measure (optional) Enter the default measure. Leave this field empty

if you create a new cube.

Fact table Either select an existing table or create anew view
using a SQL statement.

4. Click on OK.

5. You can now add measures to the cube.

Adding a Dimension

To add a shared dimension:

" Click on k%IEI to create a new dimension.
2. The cursor will change to a crosshair. Move the cursor near the left of the Playpen area, and click.
3. The dimension properties dialog box appears.

4. Enter the following information:

Inthisfied ... Dothis...

Name Enter the dimension name.

Caption Enter the dimension caption.

Type Select if your dimension is a standard dimension
or atime related dimension.

Adding a Measure

To add a measure:

1. Select the cube you want to add the measure to.

2. (51
Click on to add ameasure to the cube.

3. Enter the following information:

Inthisfield ... Dothis...

Name Enter a measure name.

Caption Enter the measure caption.

Aggregator Select the aggregate function (sum, count, min,
max, avg, distinct-count).

Value Either select the column the measure is based on
or write an expression.
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Adding a Role

The creation and editing of rolesis not supported yet.

Importing a multidimensional Data Model

To import an OLAP schema select OLAP->Import Schema. After selecting the schemafile you can enter
the name of the schema and select the related database.

Exportng a multidimensional Data Model

Y ou can export OLAP schemesto PDF and XML with right-clicking on the Playpen in the OLAP Schema
Editor. To export it to XML select 'Export Schema...’, to export it to PDF select 'Export Playpen to PDF.
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Chapter 5. Setting up Database
Support

There are many features within Power* Architect that involve connecting to adatabase, such asreverseand
forward engineering. Power* Architect allowsyou to use any JDBC- or ODBC-accessi ble source database.
For more information on supported databases, see the section called “ Supported Database” .

Connecting to a database with Power* Architect involves the following steps:

1. Definegeneral settingsand driversfor the database platform you plan to connect to (such as SQL Server
or Oracle). For more information, see the section called “ Setting up Database Types’ .

2. Create a connection to a specific database server. This connection uses the general settings and drivers
you have configured for the database platform. For more information, see the section called “ Setting
up Database Connections” .

Supported Database

Power* Architect provides full or partial support for the following database platforms.

Database Support Notes

Oracle Fully supported.

SQL Server Fully supported.

PostgreSQL Fully supported.

MySQL Fully supported.

IBM DB2 Partial support; needs more testing.

HSQLDB Works; used in samples.

Derby Preliminary support exists. Reverse engineering

databasesin Derby 10.3.2 or later ispossible. Derby-
specific forward engineering is not yet available;
however, you can try using the forward engineering
support for another platform such as MySQL or
HSQLDB. Please post to our web support forum if
you are interested in forward engineering your data
modelsto Derby.

Setting up Database Types

Y ou must define general settings for the database platforms you plan to work with (such as SQL Server,
MySQL, Oracle, DB2, etc.). These settingswill be used by Power* Architect when you set up aconnection
to a specific database server.

Note: Remember, at thispoint you are configuring general settings only and are not connecting to aspecific
database. For more information on connecting to a database, see the section called “ Setting up Database
Connections” .

» Genera settings for several database platforms are already pre-configured in Power* Architect. If you
plan to work with one of these database platforms, all you need to do is define the location of the JDBC
driver. For more information, see the section called “ Defining the JDBC Driver” .
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* You can also define additional database platforms in Power* Architect. For more information, see the
section called “Adding a New Database Type” .

Adding a New Database Type

To add a new database type:
1. Select File » User Preferences.
Alternate method:

* Select Connections » Database Connection Manager or Window » Database Connection Manager.
On the Database Connection Manager dialog box, click JDBC Drivers.

The User Preferences dialog box appears, with the JDBC Drivers tab open. Existing database types,
including the pre-defined database types included with Power* Architect, are listed on the | eft.

ene User Preferences
! General ~ JDBC Drivers !
Oracle 8i [ General | Kettle Advanced Properties
Oracle 9i
Oracle 10g Name SQL Server
PostgreSQL
Driver Class com.microsoft.sglserver.jdbc.SQLServerDriver
MySQL
DB2 Connection String Template jdbc:sqglserver://<Hostname>:<Port:1433>
E:E!t:_\é;mbedded Options Editor Preview (based on URL template)
SQL Server 2000 Sample Options Hostname Port 1433
SQL Server 2005 . =
Default Properties SQL Server ™
(AddJAR...) ( Remove JAR

| {Users/yefei/Desktop/Power*Architect.app/Contents /Resources/Java/jdbc/sglserver_2005
¢ com.microsoft.sqlserver.jdbe.SQLServerDriver

1!
-

+HE]

———

’l
Note: Y ou can modify an existing database type by clicking on it in the list.
2. Click + below thelist of database types.

3. Enter the following information on the General Tab:

Name Name for the database type (for example,
PostgreSQL or SQL Server).
Driver Class Java class name of the driver. This is the driver

class within the JDBC driver JAR file that will be
used for database connections.

Connection String Template
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General format of the JDBC URL for the database
platform.

Important: You are not creating a connection for
a specific database - you are entering a generic
connection string that applies to the database
platform. Later on, when you set up a connection
to a specific database, Power* Architect will use
this template to create the URL to connect to the
database.

The connection string template must conform to a
specific pattern that includesliteralsand variabl es.

 Literas are entered like normal text but may
not contain angle brackets (< or >), which are
reserved for defining variables. As the name
implies, literals appear in the URL in the same
position and way they appear in the template.

e Variables are used to for values that change
often, such as the schema or database
name you wish to connect to. To define
a variable in the template, use the format
<variable name:default value> (to include a
default value) or <variable_name> (if you don't
want to include a default value). If you use
a default value. it is entered automatically
when you create a database connection. You
can modify the value if the database you are
connecting to is configured to use a different
value.

Each variable you define is shown below the
Connection String Templatefield. Thisprovides
youwith apreview of thevaluesyou will beable
to modify when creating a database connection.

For example, the connection string template to
connect to aMicrosoft SQL Server database might
look like this:

jdbc:sglserver://<Hosthame>:<Port;1433>

When you create a connection to a specific
SQL Server database, Power* Architect will use
this template to create the connection URL. In
this example, the template will create the URL
"jdbc:sglserver://:1433", where 1433 isthe default
port value. Since SQL Server databases listen to
port 1433 by default, it makes sense to include
this value in the template. When you're creating
the actual database connection, you can changethe
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Inthisfield ... Enter the following information ...

port value if the database you're connecting to is
configured differently.

4. The settings on the Kettle tab are only used when you create a Kettle job. For more information on
these settings, see the section called “Using Kettle Jobs” .

808 User Preferences
! General -~ JDBC Drivers !
! General - Kettle = Advanced Properties '

Oracle 9i

Oracle 10g
PostgreSQL

SQL Server
MySQL

DB2

Derby Embedded
HSQLDB

SQL Server 2000
SQL Server 2005

Kettle Connection Type Oracle

=]

P

5. Click OK.

Next, you must define the location of the JDBC driver for the database type. For more information, see
the section called “ Defining the JIDBC Driver” .

Defining the JDBC Driver

Whether you are adding a new database platform to Power* Architect or want to use one of the pre-
configured platforms, the last step in setting up a database type is to locate the JAR file (or files) that
contain the JDBC drivers for the database platform.

Note: Remember, at this point you are just telling Power* Architect where the drivers are. You must set
up a database connection in order to connect to a specific database server (for more information, see the
section called “ Setting up Database Connections” ).

Unlike most applications, which need adistinct driver program to communicate with each type of database,
Power* Architect uses Java-based drivers. These drivers normally come from the database vendor in the
form of JAR (Java Archive) files. JAR files are an extension to the file format used by PKZip/WinZip
archives.
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Most database platforms provide drivers that are fully backward compatible. This means that it is best
to use the newest driver available, regardless of the software version on the specific database server you
intend to connect to. One exception to thisisthe Oracle database. It isimportant to match the major version
number of your JDBC driver with the major version number of the Oracle database server you connect to.
For example, if you are connecting to an Oracle 10g database, use the latest Oracle 10g driver. If you are
connecting to an Oracle 9i database, use the Oracle 9i driver.

To define the JIDBC driver for a database type:

1. If you do not have the JDBC driver for a specific database platform, you can usually obtain one
from the database vendor. If that fails, you can find a directory of databases drivers on Sun's
web site [http://developers.sun.com/product/jdbc/drivers] . There is dso a permanent thread in the
Power* Architect user support forum [http://www.sglpower.ca/forum/posts/list/401.page] , where you
can share information with other Power* Architect users about finding and configuring drivers for a
particular database platform.

2. Decide on apermanent location to store your JDBC drivers. A good strategy isto create aJDBC folder
under your Documents folder and collect all of you JDBC driver files there.

. Save the IDBC driver (it will usually be one or more JAR files) in the location you've chosen.
. If the User Preferences dialog box is not already open, select File » User Preferences.

. Onthe JDBC Driverstab, select a database type.

o 0o A~ W

. Click Add JAR.

7. Locatethe JAR fileand click Open. If thereisavalid driver classinthe JAR file, afile tree will appear
showing the JDBC driver classes within the JAR file.

8. Select the driver you want to use.

9. Click OK.

Setting up Database Connections

You must set up a connection to allow Power* Architect to connect to a specific database. When you
create a connection, it is automatically added to the current Power* Architect project. You can also use
the connection in al your projects.

Before creating a connection, you must define the general settings for the database platform. For more
information, see the section called “ Setting up Database Types’ .

Creating a New Database Connection

To create a new database connection:
1. Select Connections » Add Source Connection » New Connection.
Alternate methods:

» Select Connections » Database Connection Manager (or Window » Database Connection Manager),
then click New.

* Right-click ablank space in the database tree, then click Add Source Connection » New Connection.

The Database Connection dialog box appears.
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[a¥aXa)

Connection Properties

! General

Connection Name Backup Server

Database Type ( PostgreSQL

Connect Options Hostname server

5432

Database dbl234

JDBC URL jdbc:postgresgl://server:5432/db1234

Username

Password

4

. On the General tab, enter the following information:

Inthisfield ...

Do this...

Connection Name

Enter aname for the database connection.

Database Type

Select the database platform you want to connect
to. Note: This list contains the database types
you defined in your user preferences. For more
information, see the section called “Setting up
Database Types' .

Connect Options and JDBC URL

Enter the connection options for the database
driver. (Theses options are based on the database
type you select.)

If you are using one of the fully-supported drivers,
the connection option parameters are added into
the JDBC URL field in the order that the Java
driver expectsto seethem (thisstring is sometimes
caled a "db URL" in Java terminology). In the
following example:

 Thedefault port number from the database type
has been entered automatically in the Connect
Options.

Note: You would not usually change a
default value unless the database server you're
connecting to has been configured to use a
different value.

e The hostname and database name have been
entered manually in the Connect Options.

e The PostgreSQL driver is being used.

Username and Password

If necessary, enter the username and password to
connect to the database.
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3. The settings on the Kettle tab are only used when you create a Kettle job. For more information on
these settings, see the section called “Using Kettle Jobs” .

4. Click OK. The new connection is added to the current project (you can view the connection in the
database tree) and is also added to the Database Connection Manager.

Adding or Removing Database Connections for a Project

You can add a previoudly created database connection to a project. (When you create a new connection,
it is automatically added to the current project. For more information, see the section called “Creating a
New Database Connection” .) You can also remove a connection from a project. Y ou cannot remove a
connection if it is being used as a source connection in the playpen.

Note: You can permanently delete connections. For more information, see the section called “Modifying
or Deleting Database Connections” .

To add a database connection to a project, do one of the following:
» Select Connections » Add Source Connection, then select a database connection.

* Right-click a blank space in the database tree, click Add Source Connection, then select a database
connection.

The database connection is added to the database tree.
To remove a database connection from a project, do one of the following:
* Right-click a database connection in the database tree, then click Remove Connection.

» Click adatabase connection in the database tree, then select Connections » Remove Connection.

Modifying or Deleting Database Connections

Y ou can modify adatabase connection’'sproperties or permanently deleteit. Y ou cannot del ete aconnection
if it isbeing used as a source connection in the playpen.

Note: Y ou can also remove a connection from a project without permanently deleting the connection. For
more information, see the section called “ Adding or Removing Database Connections for a Project” .

To modify a database connection:
1. Select Connections » Database Connection Manager (or Window » Database Connection Manager).
2. Select adatabase connection, then click Edit.
Alternate methods:
* Right-click a database connection in the database tree, then click Connection Properties.
* Select a database connection in the database tree, then select Connections » Connection Properties.
The Database Connection dialog box appears.

3. Modify the connection settings. For information on the settings, see the section called “ Creating aNew
Database Connection” .

4. Click OK.
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To permanently delete a database connection:
1. Select Connections » Database Connection Manager (or Window » Database Connection Manager).

2. Select adatabase connection, then click Remove.
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Chapter 6. Setting Preferences
Defining Project Settings

Y ou can define several settings that apply to all Power* Architect projects.

1. Select File » Project Settings. The Project Settings dialog box appears.
806 Project Settings

Snapshot Entire Source Database in Project File? | |

Number of Common Values in Profiles: 10
Profile Creator Mode: " Remote Database | % ]
Draw Relationships With: E} Rectilinear Lines
:. Direct Lines
@ Show Primary Key Columns @ Show PK Tags
™ Show Foreign Key Columns M Show EK Tags
@ Show Indexed Columns E Show AK Tags

@ Show Unigue Columns
@ Show Remaining Columns

(" Cancel ) ( 0K )

A

2. Enter the following information:

Snapshot Entire Source Database in Project File? ([When you open a source database in
Power* Architect (for example, to use for
reverse engineering), the database's data structure
(catalogues, schemas, tables, etc.) is shown in the
database tree. Select this check box if you always
want to save the entire data structure in your
Power* Architect project. This allows you to view
the objects at any time without having to reconnect
to the source system.

Important: If you use this option, the first timeyou
saveyour project will bevery time-consuming and
involve alot of database activity.

Number of Common Valuesin Profiles When profiling a database using graph view, you
can view the most common values that occur
in a column. Use this option to set the number
of common values to include in the profile. For
example, enter 10 if you want to include the ten
most common values.

For more information about profiling, see the
section called “Profiling Data” .

Profile Creator Mode Select the mode used to create a profile.
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* Remote Database - This mode sends a query
to the database and the database calculates all
of the statistics. This works well over a large
network because very little datais transferred.

* Local Reservoir - This mode transfers all of the
data to the local computer where it is sampled
and processed. This works well over a fast
network. This option is still experimental and is
known to cause an out of memory error when
profiling large tables.

For more information about profiling, see the
section called “Profiling Data” .

Draw Relationships With

Select the method used to draw relationship lines
in the playpen.

Note: Changing this option affects new and
existing relationship lines.

* Rectilinear Lines - Use horizontal and vertica
line segmentsto connect tables. Onetothreeline
segments will be used (at right angles to each
other) depending on the position of the tables at
each end of the relationship line.

 Direct Lines- Useasingleline segment (usually
diagonal) to connect the tables.

Show Options

Select how to display your project in the playpen.

Note: Changing these options affects new and
existing columns and tags.

» Show Primary Key Columns - display Primary
Key Columnsif checked, else otherwise.

» Show Foreign Key Columns - display Foreign
Key Columns if checked, else otherwise.

» Show Indexed Key Columns - display Indexed
Key Columnsif checked, else otherwise.

e Show Unique Key Columns - display Unique
Key Columnsif checked, else otherwise.

e Show Remaining Key Columns - display rest
Columnsif checked, else otherwise.

» Show PK tags - display [PK] tags for Primary
Key columnsif checked, else otherwise.

» Show FK tags - display [FK] tags for Foreign
Key columnsif checked, else otherwise.
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Inthisfield ... Dorthis...
e Show AK tags - display [AK] tags for the
columns which belong to the unique indexes.
3. Click OK.

Setting User Preferences

Y ou can set preferences that apply to all Power* Architect projects.

Note: This section describes general user preferences and default column settings only. For information on
JDBC drivers preferences, see Chapter 5, Setting up Database Support . Y ou can also set project settings
(see the section called “ Defining Project Settings” ).

1. Select File » User Preferences. For Macintosh, select Architect » Preferences.

The User Preferences dialog box appears.

7% User Preferences

General f’JDBC Drivers rDelau\lCO\umn Settings |

PL.INI File

ETL Log File

Error Reporting

Show Welcome Screen

|C:\F‘rogram Files\Power Loader Suite\plin

|C \Users\adminletl.log

Forward Engineering Log File

|C.\Users\admin\dd|.lug

‘Antialiased Rendering in PlayPen

on

® On

) Off

) off

i Yes @ Ho

oK | ‘ cancel

2. On the General tab, enter the following information:

PL.INI File

Enter the location for the pl.ini file. This file
storesthe settingsfor the database connectionsyou
create. If you leave thislocation blank, you will be
prompted to use a default location when you start
Power* Architect.

If you have a pl.ini file from another SQL
Power application, you can use the same file for
Power* Architect so that you don't have to re-enter
all of your database connection information.

ETL L og File
beJ
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Inthisfield ...

Do this...

Enter the location for the etl.log file. Thislog file
is written to when you use the ETL features in
Power* Architect.

Forward Engineering Log File

Enter the location of the ddl.log file. Thislog file
is written to when you forward engineer a data
model.

Antiaiased Rendering in PlayPen

Turn on this option to improve the display of the
data model diagrams in the playpen, especialy
when zoomed out. This option may cause slower
performance on some systems. Using this option
is recommended unless you experience poor
performance.

Error Reporting

Turn on this option to send automatic error
reportsto SQL Power. Error reports never include
any information that could be used to identify
you or the contents or subject matter of your
project. They ssimply include a Java stack trace
that tells developers where in the program code
Power* Architect encountered a failure, as well
as generic information such as the version of
your Java Runtime Environment and the amount
of RAM Power*Architect is currently using.
These eror reports help the Power* Architect
devel opment team prioritize bug fixes based on the
estimated number of timesaparticular problem has
been encountered.

Show Welcome Screen

Turn this option on to view the welcome screen
when you start Power* Architect.

3. Click OK.

4. On the Default Column Setting, enter the following information:

Inthisfield ... Dothis...
Column name by Default Enter the default column name.
Column type by Default Select the default column type.

Column Precision by Default

Enter the default column precision.

Column Scale by Default

Enter the default column scale.

Column in Primary Key by Default

Select if column should be in primary key by
defaullt.

Column Allows Nulls by Default

Select if column should alow Nulls by default.

Column Auto Increment by Default

Select if column should Auto Increment by default.

Column Remarks by Default

Enter Column default remarks.

Value by Default

Enter default value.




Chapter 7. Reverse Engineering a Data
Model

Y ou can use reverse engineering to obtain a data model from an existing database, then work with the data
model in Power* Architect. Y ou can also use Power* Architect to create an upgrade script for the origina
database (for more information, see the section called “Comparing Data Models’ ).

Y ou can also use reverse engineering for data warehouse design, where your objective isto unify several
data models and then import the data from the multiple source systems. To do this, you would typically
reverse engineer one table at a time from several different source systems, then make modifications in
Power* Architect, using the playpen. Y ou can then forward engineer the new data warehouse data model
to a new, separate database (for more information, see Chapter 8, Forward Engineering a Data Model ,
then use an ETL tool to transfer the data from the source systems to the data warehouse.

For more information, on ETL tools in Power* Architect, see the following sections:
* the section called “Using Kettle Jobs’

» the section called “Creating a Visual Mapping Report”

* the section called “ Exporting Column Mappings’

To reverse engineer adata model:

1. To create anew Power* Architect project, select File » New Project.

2. If necessary, create a connection for the database you want to reverse engineer. For more information,
see Chapter 5, Setting up Database Support .

3. Add the database connection to your project. For more information, see the section called “ Setting up
Database Connections” .

A database node is added to the database tree. Expand this node to view the hierarchy of objectsin the
database (such as catal ogues and schemas, tables, columns, indices, and relationships). The hierarchy
is presented the same way a native database tool for the source database platform would present the
hierarchy.

As you click objects in the database tree, the object changes from grey to black to indicate you've
viewed it. All viewed items are saved with the project so you can view them later without having to
reconnect to the source system.

Note: If you want to save the entire hierarchy in the project, enable the snapshot option in project
settings. For more information, see the section called “ Defining Project Settings” .

4. You can now create a new data model using the objects from the database tree. Simply drag objects
from the tree into the playpen.

If you drag higher-level containers (such as a schema, catalogue, or the entire database), individua
tables, or multiple tables, al items within the container will be added to the playpen. For example, if
you drag atable into the playpen, all of the columns within the table will be added as well. You can
also drag individua or multiple columns from the database tree into tablesin the playpen. Just drag the
columns to the position within the table where you want to insert them.
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In addition to using objects from the database tree, you can create new objects (tables, columns, etc.) inthe
playpen. For more information on working with the playpen, see Chapter 3, Creating a relational Data
Model .

Y ou can also do the following:

» Create areport listing the source tables used for the tablesin the playpen. For moreinformation, seethe
section called “Creating a Visua Mapping Report” .

e Compare your current data model to the original database. For more information, see the section called
“Comparing DataModels’ .

 Forward engineer the schema. For moreinformation, see Chapter 8, Forward Engineering a Data Model

» Use aKettle job to move data from the origina database to your new database. For more information,
see the section called “Using Kettle Jobs” .
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Model

A key design principle of Power* Architect isthat the data models you create always remain generic. This
allows you to use the same data model with a variety of database platforms. Y ou can then use forward
engineering to transform a data model for a specific database platform.

When you forward engineer a data model, Power* Architect creates a physical model that represents the
idealized generic model as closely as possible, given the constraints of the target system. Power* Architect
then creates a SQL Script that you can run to place the components of the data model into a database.

It is important to note that Power* Architect creates the structure of the target database only and does not
create the actual database. Before using forward engineering, you must create the target database. Y ou
would typically do this using the administrative tools provided for the database platform.

Note: You can view or change the location of the forward engineering log file in user preferences. For
more information, see the section called “ Defining Project Settings” .

To forward engineer adata model:

1. Open the Power* Architect project containing the data model you want to use. Ensure that all of the
data model elements you want to forward engineer are included in the diagram in the playpen. Make
any required changes, such as:

* Creating new tables.

* Renaming or deleting existing tables.

* Creating new columns.

» Renaming or deleting existing columns.
* Moving columns between tables.

* Modifying column data types.

» Merging two or more tables together. (If the tables you merge have a parent-child relationship, this
is called denormalizing the data model.)

» Splitting atable into several related tables (thisis often called normalization).

2. Create the target database. Y ou would typically do this using the administrative tools provided for the
database platform.

3. If necessary, create a connection for the target database. For more information, see Chapter 5, Setting
up Database Support .

4. Add the database connection to your project. For more information, see the section called “ Adding or
Removing Database Connections for a Project” .

==y
Click #8L on thetop toolbar, or select Tools» Forward Engineering. The Forward Engineer SQL Script
dialog box appears.
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ene Forward Engineer SQL Script
Create in: ' SampleDB B ( Properties )
il el
Cenerate DDL for Database Type: PostgreSQL = 1
(no catalog)
Schema public|

( Cancel ) ( OK )

A

6. Enter the following information:

Inthisfied ... Dothis...

Createin Select the database connection for the target
database.

Generate DDL for Database Type Select the database platform. This is the same

database type you specified when you created the
connection for the target database.

All remaining fields Enter information appropriate to the database type
you selected.

7. Click OK. Power* Architect generates a SQL script to create the data structure currently in the playpen.
Note: As Power* Architect is generating the script, warnings or error reports may appesar.

8. The Preview SQL Script dialog box appears. For example:
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806 Preview S0L Script

Your Target Database is SampleDB

CREATE TABLE public.customers
customer_id INTEGER NOT NULL,
firstname VARCHAR(40) NOT NULL,
lastname VARCHAR(40) NOT NULL,
city VARCHAR(40) NOT NULL,
province VARCHAR(40) NOT NULL,
countrycode CHAR(2) NOT NULL,
postcode VARCHAR(1O) NOT NULL,
CONSTRAINT customers_pk PRIMARY

KEY (customer_id)

%

CREATE TABLE public.orders [
order_id INTEGER NOT NULL,
guantity INTECER NOT NULL,
total_amount INTEGER NOT NULL,
customer_id INTEGER NOT NULL,
CONSTRAINT orders_pk PRIMARY KEY

(order_id)

%;

ALTER TABLE public.orders ADD CONSTRAINT
customers_orders_fk

FOREICN KEY (customer_id)

REFEREMNCES public.customers (customer_id)
ON DELETE NO ACTION

ON UPDATE NO ACTION

NOT DEFERRABLE;

( Copy ) f—Execnte} ( Save ) ( Cluse)

A

9. Torun the script, click Execute. The database objects are created in the target database.
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Comparing Data Models

Y ou can compare two data models to view the differences and similarities. Y ou can compare a database
to a Power* Architect project or to another database.

The data model comparison provides you with a description of the two data models, highlighting their
differences and similarities, which you can copy into a document or save to atext file. Y ou can also use
the data model comparison to generate and run a SQL script that will update the older database to match
the newer data model.

To compare two data models:

1 -]
Click I:E_'J on the top toolbar, or select Tools » Compare DM. The Compare Data Models dialog box

808 Compare Data Models
Compare Older
() Current Project [test]
@ Physical Database schema
test ) = [pusLIC B ( New.. )
) From File:
Ch
With Newer
@ Current Project [test]
() Physical Database Catalog Schema
(Choose a Connection) 5
) From File:
Ch
Output Format.
M soLfor HSQLDB e ] to make Older look like Newer

(_ English descriptions

| Suppress similarities

Status

Swap ( cancel )

F

2. Inthe Compare Older and With Newer sections, select the data models you want to compare.

» Select Current Project - Include an open Power* Architect project in the comparison. The data model
currently in the playpen will be used.

» Physical Database - Include an existing database in the comparison. You must also select the
connection Power* Architect will useto connect to the database. For moreinformation, seethe section
called “ Setting up Database Connections” .

» From File - Include an existing Power* Architect project in the comparison. Click Choose and select
the project.

Note: If you want to switch the items you've selected in the Compare Older and With New sections,
click Swap.
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3. Inthe Output Format area, select whether you want to create a SQL script or an English comparison.
4. Select the Suppress similarities check box if you want to include only the differences in the output.
5. Click Start. The data model comparison is created.

Note: The Start button is only available if both data modelsin the comparison are valid.

See the following sections for details on the information shown in the data comparison.

Data Model Comparison with English
Descriptions

If you chose English descriptions as the output format, the older and newer data models are shown side-
by-side. Y ou can copy the results to the clipboard or save them to atext file.

The comparison includes descriptions to make the older data model the same as the newer data model.
The components are also colour coded to indicate similarities and differences.

The following table summarizes the meaning of the colour codes used in the data model comparison:

Colour Description

Black The component exists in both data models.

Green The component existsin this data model only.

Red The component does not exist in this data model but

does exist in the other data model.

Blue The component isacolumn and is on different keys
in the two data models.

Data Model Comparison in SQL Script

If you chose SQL script as the output format, a script is created to make the older data model the same as
the newer data model. Y ou can copy the script to the clipboard or save it to atext file.

To run the script and apply the changes to the older database, click Execute.

Note: The Execute button is only availableif the older database has avalid database connection. For more
information, see the section called “ Setting up Database Connections” .

Profiling Data

Profiling allows you to view a summary of the data in a database. Y ou can use profiles to quickly learn
the characteristics of data in an unfamiliar database. You can also use profiles for activities such as
database optimization and data migration. When you create a profile, the results are saved as part of the
Power* Architect project.

Note: Power* Architect contains two different menu items related to profiling. Use Profile » Profile only
when you want to create a new profile. If you want to view existing profiles, use Window » Profile
Manager. (The profile manager window is similar to the download manager window in aweb browser.)
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Setting the Profile Mode

Y ou can select the mode used to create a profile.
1. Select File » Project Settings.
2. Inthe Profile Creator Mode list, select one of the following options:

» Remote Database - This mode sends a query to the database and the database calculates all of the
statistics. This system works well over alarge network because very little datais transferred.

Warning: Profiling moderate-to-large tables (for example, with over 250,000 rows) remotely will put
a significant demand on the database server's resources and may impact the database performance
for other users.

» Loca Reservoir - This mode transfers all of the data to the local computer and then samples and
processes the data there. This works well over afast network. This option is still experimental and
may cause an out of memory error when profiling large tables.

3. Click OK.

Creating a Profile

To create aprofile:

1. Connect to the database you want to profile. For more information, see the section called “ Setting up
Database Connections” .

2. In the database tree, select the tables you want to profile. (You can also select a column. If you do, a
profile will be created for the entire table.)

Click |.L|.|J in the top toolbar.

Alternate methods:

 Select the tables you want to profile, then select Profile » Profile.
 Right-click atable in the database tree, then click Profile.

The Table Profileswindow opens. The new profileislisted in the window, along with previous profiles
you've created for the project.
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enNe Table Profiles
Search @ | Order by @ Name () Date

CUSTOMERS @
Rows: 0 Dec 11, 2007 4:13:51 PM Time: 6 ms —
EXAMPLETAELE @
Rows: 2000 Dec 11, 2007 4:13:50 PM Time: 252 ms —
GROUP_OBJECT_PRIVS —
Rows: 0 Dec 11, 2007 4:13:51 PM Time: 12 ms i
GROUP_SYSTEM_PRIVS )
Rows: 0 Dec 11, 2007 4:13:51 PM Time: 19 ms —
MM_COLUMMN_MERGE_RULE @
Rows: 0 Dec 11, 2007 4:13:51 PM Time: 12 ms —
MM_MUNGE_PROCESS @
Rows: 0 Dec 11, 2007 4:13:51 PM Time: 15 ms —
MM_MUNGE_STEP )
Rows: 0 Dec 11, 2007 4:13:51 PM Time: 13 ms —
MM_MUNGE_STEP_INPUT @ ]
Rows: 0 Dec 11, 2007 4:13:50 PM Time: 84 ms —

( View All ) ( View Selected ) Showing 27 of 27 Profiles ( Delete All ) { Close |

A4

4. You can view details about each profile in the Table Profiles window. For more information, see the
section called “Viewing Profile Details” .

Note: To create a new profile of the same table, select the table in the Table Profiles window and click

=
= . The previous profile will be retained as well. (Power* Architect will connect to the source database
to create the new profile, regardless of the profile mode you're using.)

Viewing Profile Details

To view profile details:

1. If the Table Profiles window is not aready open, select Window » Profile Manager.
2. You can use the Search box and Order by optionsto find a profile.

3. Toview detailsfor al profiles, click View All.

4. To view details for some profiles only, select one or more profiles in the window, then click View
Selected.

You can view the profile details as a graph or table. For more information, see the section called “Using
Profile Graph View” and the section called “Using Profile Table View” .

Using Profile Graph View

To view the profile resultsin a graph:

* Click the Graph View tab.
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[cJSXG]

Table Profiles

{"Graph View | Table View -

EXAMPLETABLE (Dec 11, 2007 4:13:50 PM)[%)

ID: INTEGER
LASTNAME: VARCHAR(100)

EMAIL: VARCHAR(100)

/ADDRESS: VARCHAR(100)

HOMEPHONE: VARCHAR(100)

CELLPHONE: VARCHAR(100)

FIRSTNAME: VARCHAR(100)

RowCount
Nullable

Null Count

% Null Records

2000

true

0
0.00

Minimum Length 2
Maximum Length 18

Unique Values

53

Top 10 most common values

% Unique 265
Minimum Value  Amor
Maximum Value  Zeppelin
Average Value
COUNT VALUE
56 Urmas-Armas
51 Wrigley
s0 Amor
49 Boo
p Baby o \(Bluebell 57
49 Legal s |
8 Poet Reverend (4]
45 Bluebell
45 Poppy
4 Reverend

(save.. ) (_Close )
%
i

* On theleft side of the window, select a column.

The column statistics are shown in the centre of the window. The most common values and their
frequency within the table are also shown.

The pie chart on the right side of the window shows the frequency of the most common values in the
column.

Note: You can set the number of common vaues to include in the comparison. For more information,
see the section called “ Defining Project Settings” .

» Tosavethe profileresultsin CSV, PDF or HTML format, click Save.

Using Profile Table View

To view the profile resultsin a table format:

1. Click the Table View tab.

606 Table Profes
Graph view | Table iew |
search
T —— Cotamn Record Count DType | ¥Rl ST 8 Uniqu % Urique Wi arg L Av, Lo
remas on andom thomas public artadmi_prees  priiege 2009-01113 05:41:41 o aRGARCe) onAONA 00
tramas on andom thomas public arsdminpieoes userrame 2009-01113 05:41:41 ovARCHR(S) oNA onm o oo
ihomas on random thomas publc arLadminprivieges  Vale 2009-01.13 05:41:41 oITEGER oNA  ONA o o0
ihomas on randon tomas publc Ll souces  Ine.umber 2009-01-13 0514152 2TEGER oos ook o 0o
thomas on andom thomas public arallsources  obecLgroip.d  2009-0113 054152 2TEGeR oos ook o oo
thomas on andom thomas public aralsources 2005-01 13 05:41:52 rece oos ook o oo
tramas on andom thomas publc aralLsources  olectype 2005-01-13 0514152 2R 00 1508 s ss
tramas on random thomas publc analsounces  tex o 2009-0113 05:41:52 2vaRceEse 00k 2100 2 w975 seeacod el
tramas on andom thomas public art_datas ariag 2009-01113 05:41:33 2 AR 210 0o o oo
ihomas on rando thoms publc ar_databases 2009-01.13 05:41:33 2TEGER oos ook o o0
ihomas on randon thoms publc. ar databases databasea 2009-01-13 05:41:33 2wTeGeR oos ook o o0
thomas on andom thomas public ardatabases ! 2009-01-13 05:41:33 2VARGHAR200) 00k 150x 2 2121 oroosresa
thomas on andom thomas public ar_dataases 20050113 05:41.33 2 Vo) 00k 2100x s 7es voms
thamas on andom thomas public ar_databases 2005-0113 05:41.33 2 VR0 2108 oo o oo
tramas on andom thomas public ar_databases 2005-0113 05:41.33 2 vaRHR(e0) 00 150% PR
tramas on andom thomas public artdatabsses 2009-0113 05:41:33 20aTe 00% o o o0
tramas on random thomas publc artcataveses 2009-01113 0514133 2aRcHRE000) 008 1508 3 33 docoosress
ihomas on randon thoms publc. ar_databsses 2009-01-13 05:41:33 2 VARGHAR(ZS) 008 1508 s se
tramas on andom thomas public artjoos 2009-01-13 05:41:37 0VARCHAR(D) onA ow o o0
thamas on andom thomas public arjoos 2005-01-13 0514137 ovaRCHRL) onA o o oo
thamas on andom thomas publc aroos 2005-01 13 05:41:37 owrecee onA o o oo
tramas on andom thomas public aroos 2005-01-13 05:41:37 owreGer oNA o o oo
tramas on andom thomas puslic artoos 2009-01.13 05:41:37 owreGer oNA o o oo
tromas on random thomas publc rt oo 2009-01113 0514137 oTESTAN oNA o o 0o
ihomas on random tomas publc L 065 2009-01-13 05:41:37 0 VARCHAR(4000) oNA  oN o o0
tramas on andom thomas public artjoos lsUsuridae 20090113 05:41:37 oTMESTANP oNA on o 0o
thomas on andom thomas public arjoos maitrom 2005-01 13 05:41:37 ovaRGHRE0) onA o o oo
thomas on andom thomas publc arobs maos 2005-01 13 05:41:37 ovaRGHRzSH) onA o o oo
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(Save. ) (Close )

N

To narrow the results, use the Search box in the top-right corner.

w

To sort acolumn in ascending or descesending order, click the column header.

In the Most Freguent column, hover over a cell to view the value and frequency of the most common
itemsin the column.
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5. To savethe profileresultsin CSV, PDF or HTML format, click Save.

Deleting Profiles

To delete aprofile:

1. If the Table Profileswindow is not already open, select Window » Profile Manager.

" Todeetea profile, click beside the profile or press delete.
3. To delete multiple profiles, use CTRL to select all the profiles you want to delete, then press delete.

4. To delete dl the profiles, click Delete All.

Saving Your Profile Results in a PDF

Y ou can easily create a PDF document that presents your profile resultsin an attractive format.
1. Create one or more profiles (see the section called “ Creating a Profile” ).
2. Select Window » Profile Manager.

3. In the Table Profiles window, select the profiles you want to include in the PDF, then click View
Selected (see the section called “Viewing Profile Details” ). Or click View All to include dl of the
profilesin the PDF.

4. Click Save.

5. Select PDF asthefile type and enter afilename, then click Save.

Creating a Visual Mapping Report

When you create a data model using reverse engineering, you can create a report listing the source tables
used for the tables in the data model. Y ou can export this report to a CSV (comma-separate values) file.

1. Select ETL » Visual Mapping Report.

2. To savethereport to aCSV file, click Export to CSV.

Exporting Column Mappings

When you create adatamodel using reverse engineering, you can export aCSV (comma-separated val ues)
file describing the source-to-target column mappings between the original database and the data model
you created in Power* Architect.

1. Open the project containing the data model you want to use.
2. Select ETL » Export CSV. The Save dialog box appears.

3. Select the location and filename for the CSV file, then click Save.
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Copying Data Across Database Platforms

Y ou can use Power* Architect to quickly copy datafrom one database platform (such as Oracle) and createa
verbatim copy on another database platform (such as PostgreSQL ). Power* Architect automatically checks
for foreign key constraintsin the target database and orders the inserts and deletes accordingly.

Y ou can also use Power* Architect to copy dataif the source and target databases are on the same database
platform. However, in this case, it's usually faster and more reliable to use the database vendor's own tools
to do a"dump-and-restore".

If you want to do something more complex than a verbatim copy, use an ETL tool such as Kettle. ETL
tools offer great flexibility in extracting, transforming, and loading data between databases. For more
information, see the section called “Using Kettle Jobs’ .

To copy data:

1. Select Tools » Copy Table Data. The Copy table data dialog box appears.

8086 Copy table data
Source Destination
> @ > @
@ @
{( Database Connection Manager... ) 1 Truncate Destination Table?

( Cancel ) ( OK )
A

2. Select the Source and Destination databases. If necessary, click Database Connection Manager to set
up a new database connection.

3. Select the Truncate Destination Table check box to delete all existing data in the destination tables
before copying the data from the source tables.
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Warning: Only use this option if you are sure you want to delete the existing data in the destination
tables.

4. Click OK.

Using Kettle Jobs

You can use Power*Architect to create a Kettle job, which you can then use to create multiple
transformations based on a data model you've created in Power* Architect. Y ou would typically create a
Kettle job to copy datato a new database you've created through reverse engineering.

Note: The Kettle ETL tool is provided by Pentaho as free and open source software. SQL Power does not
maintain or distribute Kettle. To obtain a copy, visit kettle.pentaho.org [http://kettle.pentaho.org/] .

Before Creating a Kettle Job

Before you create a Kettle job, you must use reverse and forward engineering to create a new data model
and database.

1. Create a new data model in Power* Architect using reverse engineering (see Chapter 7, Reverse
Engineering a Data Model ).

2. Forward engineer the data model into a new database (see Chapter 8, Forward Engineering a Data
Model ). This creates the tables and relationships in the target database.

Creating a Kettle Job

Before creating a Kettle job, ensure you've completed the prerequisites (see the section called “Before
Creating aKettle Job” ).

Note: You can view or change the location of the Kettle (ETL) log file in user preferences. For more
information, see the section called “ Setting User Preferences’ .

1. Open the project containing the data model you want to use for the Kettle job.

2. Select ETL » Create Kettle Job. The Create a Kettle Job dialog box appears.
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O086 Create a Kettle Job

Job Mame: test

Target Database: [ (Target Database)

| :! ( Properties... )

el e

Schema Name:

Default Join Type: "INNER

%) Save Job to File

Path:

[ Browse... |

The transformations will be stored in:

") Save Job to Repository

Repository: [ Sample-HSQLDB

| :! { Properties... )

— S

Check that the target database is the same as the play pen.

3. Enter the following information:

e “w
( Cancel ) € 0K )

A

Job Name

Enter aname for the job.

Target Database

Select the database connection for the target
database.

Click Properties to view the connection and
modify it if necessary. Ensure the connection
contains the following information:

* General tab - Enter al the required connection
properties for the database platform. (See
the section called “Setting up Database
Connections’ .)

« Kettle tab - Enter the hostname, port, and
database for the target database, if applicable. If
afield does not apply to the database platform,
it will be disabled. You do not have to enter a
login name and password.

Note: The hostname, port, and database
information may be entered automatically based
on the information on the General tab.

Schema Name

Enter the name of the schemain the target database
that containsthetarget tables. If thetarget database
doesn't contain any schemas, or the target tables
are in the default schema, you can leave this field
blank.

Default Join Type

Select the join type to use in al merge-joins.
Merge-joins are used to create tables with multiple
SOurces.
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In thisfield ... Do this...

Notee Mergejoins that are created in
transformations from Power*Architect will
usuadly have to be updated manually, since
Power* Architect cannot tell which fields to
compare during thejoin.

Save Job to File Select thisoption to savethe K ettlejob settingsand
transformations to afile. Click Browse and select
the location and filename.

Save Job to Repository Select thisoption to savethe K ettlejob settingsand
transformations in arepository.

In the Repository list, select the database
connection for the repository. You can use a
connection you have set up previously (if the
database contains a repository) or you can set up
anew connection to arepository. (See the section
called “ Setting up Database Connections’ .)

Click Properties to view the connection and
modify it if necessary. Ensure the connection
contains the following information:

* Genera tab - Enter all the required connection
properties for the database platform. (See
the section caled “Setting up Database
Connections’ .)

» Kettle tab - Enter the hostname, port, and
database for the repository, if applicable. If a
field does not apply to the database platform, it
will bedisabled. Enter therepository login name
and password.

Note: The hostname, port, and database
information may be entered automatically based
on the information on the General tab.

4. Click OK to create the Kettle job and transformation files.

If you are using arepository, you are prompted to select the directory location in the repository where
the files will be saved.

Once the job has been created, a window appears with the steps you need to complete before running the
Kettle job.

Note: The transformation files are stored in the same location as the Kettle job. You must use Kettle to
run the job.
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Chapter 11. Universal SQL Access

Universal SQL Accessisa"fall-back” tool that lets you work at the raw SQL command level. Thisisan
advanced topic and should only be used by those familiar with the intricacies of SQL commands and the
details of your database.

Universal SQL Access is started from the menu entry under the Tools menu, and begins with the GUI
window shown below. The first thing you should do is select which database connection you wish to use.
Thelist of Connectionsisthe same as the main program uses, as set up in the JDBC Connections window.

Thebasic stepsto using Universal SQL Access are to type acommand in the top (SQL Command) section
of thewindow and click the Execute button; the results are displayed in the bottom (SQL Results) section.
To save you some typing, you can just drag the databases, tables and columns shown in the DB tree at the
left of the Universal SQL Access window and drop them on the top (SQL Command) section.

8086 SQL Query
» (& PlayPen Datab.

- %

¥ (@ thomas on ran g Stop E Commit| Rollback
v @ thomas = ¢ - \ e T 1000
G "] ( Manage Connections... )  Row Limit 1,000 -

» (& informa ——
= 1|SELECT * FROM thomas.public.art_all sources
» & pg_cata e

» (& pg_toas
» (& public
v @ vefel
v (@ yefei
» (& informa
» @ pg_cata
» (& pg_toas

» (& public

themas on random

Log | Result )

object_id object_group_id object_type line_number. text_info
5 1 QUERY 1 select location_name, name, profit from sales_loc s, sales_rep sr where sl.sale
4 1 QUERY 1 select col2, coll from art_sucks

Dy v
[ — ] T 4

You can enter more than one SQL statement in the SQL Command section. If you do this, be sure to
terminate each one with a semicolon. If you enter only one SQL statement, the terminating semicolon is
unnecessary. The statements are not interpreted by Universal SQL Accessitself, so anything that the given
database and driver accepts can be used. For example, with Oracle, you can use PL/SQL statements. With
most drivers you should be able to use stored procedures.

To execute your commands, use the mouse to press the execute button, or hit Ctrl-Enter (Command-Enter
on Mac). Normally, all statementsin the SQL Command text areawill be executed in sequence. However,
if thereisaselection (in other words, some of the text is highlighted) when you execute, only the selected
text will be executed. So if you only want to execute a subset of the commands, simply select the part
you wish to execute.

By default, auto-commit is enabled, which means each SQL statement is executed in its own transaction
context. Be careful, because this means the effects of your update and del ete statements are not undoabl e!
If you turn the Auto Commit off, and your database supports transactions (most do), you can manually
Commit or Rollback later.

Output (Results) Window

Command Output appears in the SQL Output window. A scrollbar will appear if the information cannot
all be seen at once.
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Universal SQL Accesskeepsalog of statementsexecuted and errors encountered. If you run an undate-type
statement, or your statement is rejected by the database, the bottom half of the window will automatically
switch to the"Log" tab so you can see the row count or database error message, respectively. Conversely,
when you execute a sel ect-type statement, the bottom half of the window switches to the tabular result set
view so you can see the data that was selected. Note that in this case, there will still be an entry in the log
tab with the date and time the query was executed, how long it took to execute, and how many rows were
selected. Y ou can see thisinformation by manually switching to the "Log" tab.

Output Formats

The output format in the result window is always Table mode, which provides afriendlier interface which
ensures all of the columns are lined up properly. If you right-click on atable or multiple tables, you can
savetheresultsto afilein HTML or CSV format. The HTML format consists of atable containing results
of the select statement. The CSV format, produces acomma-separated val uesfile with aheader row, which
is suitable for importing to any spreadsheet program, such as Microsoft Excel or OpenOffice Calc.

CSV filesare often used as asimple way to transfer alarge volume of spreadsheet or database information
between programs, without worrying about special file types. For example, transferring a home-made
address book from Power* Architect into a database program such as Filemaker Pro could be done by
exporting the file asa CSV from Excel, then importing that CSV into Filemaker.

For example, here are the results of executing the select statement, "select * from art_logs":
8086
public
| art_admin_privileges ( Z Stop E Commit | Rollback
| art_all_sources (TABLE - ™
] art (TABLE
“lartjobs (TABLE) ExcafareWlogn
] art_jobs_audit (TABLE
] art_jobs_parameters (|
" art_iogs (TABLE)

] art_queries (TABLE)
] art_query_fields (TAB]
| art_guery_groups (TAI
] art_query_rules (TABL
| art_rules (TABLE)

| art_sucks_result (TABL|
] art_truly_does_suck (T
] art_user_queries (TAB|
| art_user_query_group
] art_user_rules (TABLE]
| art_users (TABLE)

1 bar (TABLE)

] comma (TABLE}

SQL Query

themas on random ( Manage Connections... )  Row Limit 1,000

1|select *

- Log | Result )

update_time username type ip
2008-09-22 17:31:02.457 thomas login  127.0.0.1
2008-09-22 17:33:20.384 admin  loginerr 127.0.0.1

object_idtotal_time fetch_time message
internal, level: 0

internal, failed

| customer (TABLE)

| foo (TABLE) -

| function_with_index (T
] image_test (TABLE)

| mm_table (TABLE) 2008-09-22 17:34:04.54 thomas login  127.0.0.1 internal, level: 0

| mm_table_result (TAB 2008-09-22 17:36:19.451 thomas login ~ 127.0.0.1 internal, level: 100

| mm_test (TABLE) 2008-09-22 17:40:32.653 thomas login  127.0.0.1 internal, level: 100
2008-09-22 17:42:15.842 thomas login  127.0.0.1 internal, level: 100

~ new.table_L (TABLE) 2008-09-22 18:08:44.54 thomas login  127.0.0.1[ | internal, level: 100

=l new._table_result (TAB, 2008-09-23 10:08:19.161 thomas login ~ 127.0.0.1 internal, level: 100

| newline (TABLE) 4| |2008-09-23 10:38:02.191 thomas object 127.0.0.1 4 0 0 query, himl .
2008-09-23 10:43:31.768 thomas _object 127.0.0.1 4 0 0 query, htmi M

| quote (TABLE) 1
[ ] <Tr

You can view this same data in HTML by right-clicking the selected table, then choosing "Exported
selected to HTML..". Hereis what the generated HTML looks like in atext editor:

2008-09-22 17:33:21.983 admin
2008-09-22 17:33:24.583 art
2008-09-22 17:33:26.606 art
2008-09-22 17:33:29.087 admin
2008-09-22 17:33:31.021 art

loginerr 127.0.0.1
loginerr 127.0.0.1
loginerr 127.0.0.1
loginerr 127.0.0.1
loginerr 127.0.0.1

internal, failed
internal, failed
internal, failed
internal, failed
internal, failed
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806 | example

<table=

<tr=
<thzupdate_time= thx
<th=uzername-- th=
<thxtvpe-/th=
<th=ip=/ths
<thzobject_id=/th=
<th=total_time="th=
<th=fetch_time=/th=
<th=meszage= th=

=ty

<Lr=
<hd=ZBA5-A9-22 17:33:28.3584 < td=
<td=admin="td=
<td=loginerr- td-
<Ld=127 8.8t d
<tds—= td=
<tds—= td=
<tds—= td=
<td=internal, foiled=/td=
< L=

<tr=
<Ld=ZBRE-A9-22 17:133:21.955td=
<Ld=admin=/td=
<td=loginerr=~/td>
<Ld=127 8.8t d
<tds—= td=
<tds—= td=

L =

o, -

and formatted in aweb browser:
8o66e Mozilla Firefox =)

@ (U file:///Users fyefei/Desktop/example 1'_,"‘) = (' )stgresq\cQ\,

Most Visited ¥  Getting Started Latest Headlines ® Changes - power-ar...

update_time username type ip  object_id total_time fetch_time message
2008-09-22 17:33:20.384 admin loginerr 127.0.0.1 internal, failed
2008-09-22 17:33:21.983 admin loginerr 127.0.0.1 internal, failed
2008-09-22 17:33:24.583 art loginerr 127.0.0.1 internal, failed
2008-09-22 17:33:26.606 art loginerr 127.0.0.1 internal, failed
2008-09-22 17:33:29.097 admin loginerr 127.0.0.1 internal, failed
2008-09-22 17:33:31.021 art loginerr 127.0.0.1 internal, failed
2008-09-22 17:34:04.54 thomas login 127.0.0.1 internal, level: 0
2008-09-22 17:36:19.451 thomas  login  127.0.0.1 internal, level: 100
2008-09-22 17:40:32.653 thomas  login  127.00.1 internal, level: 100
2008-09-22 17:42:15.842 thomas  login  127.00.1 internal, level: 100
2008-09-22 18:08:44.54 thomas login 127.0.0.1 internal, level: 100

wione,

With the addition of acustom CSS style sheet, thisHTML page could fill abasic reporting need. For more
advanced report layout, be sure to try Wabit [http://www.sqlpower.ca/wabit], the open source reporting
tool from SQL Power.
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Chapter 12. Troubleshooting

Although we have done our best to ensure you don't experience any problemswhen using Power* Architect,
there may be times when combinations of different database products, database configurations, and so on,
cause issues. We apologize in advance for any inconvenience this may cause.

If you are having trouble with Power* Architect, we ask that, in order to help us to diagnose the problem,
you take some or al of the following actions:

* Prepare adescription of what you were doing.
» Prepare acopy of any errors you encountered.

* Post your problem to the Power* Architect help forum. [http://www.sqglpower.ca/forum/forums/show/
2.page]
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Chapter 13. Glossary

This section lists some database-related terms and their meanings.

Some of these terms are from FolDoc, "The Free On-line Dictionary of Computing”, http://

www.foldoc.org/, Editor Denis Howe.

Column

The set of al instances of a given field from
al records in a table [http://foldoc.org/foldoc/
foldoc.cgi?table] .

Database

One or more large structured sets of persistent
data, usually associated with software to update and
query [http://foldoc.org/foldoc/foldoc.cgi?query]
the data A simple database might be a single
file containing many records [http://foldoc.org/
foldoc/foldoc.cgi?records] , each of which contains
the same set of fields [http://foldoc.org/foldoc/
foldoc.cgi ?fields] where each field is a certain fixed
width.

Data Modelling

The product of the database design process which
aims to identify and organize the required data
logically and physicaly.

Data Warehousing

A database, often remote, containing recent
snapshots of corporate data. Planners and
researchers can use this database freely
without worrying about slowing down day-to-day
operations of the production database.

ETL

Extraction, Transforming and Loading - the process
of maintaining and transforming datainto and out of
arelational database.

Foreign key

A column [http://foldoc.org/foldoc/
foldoc.cgi?column] in a database table [http:/
[foldoc.org/foldoc/foldoc.cgi Ztable] containing
values that are aso found in some
primary key [http://foldoc.org/foldoc/
foldoc.cgi?primary+key] column (of a different
table). By extension, any reference to entities of a
different type.

Some RDBMSs [http://foldoc.org/foldoc/
foldoc.cgi’lRDBMSs] adlow a column to be
explicitly labelled as a foreign key and only allow
values to be inserted if they aready exist in the
relevant primary key column.

I dentifying Relationship

Where the key of the parent table is a subset of the
key of the child table.

JDBC

Java DataBase Connectivity, an unofficial acronym
for the "java.sgl" package of functionality used to
accessrelational databasesfrom programswrittenin
the Java programming language.
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Key

A value used to identify a record [http://foldoc.org/
foldoc/foldoc.cgi?record] in a database, derived by
applying some fixed function to the record. The
key is often simply one of the fields [http:/
[foldoc.org/foldoc/foldoc.cgiXields] (a  column
[http://foldoc.org/foldoc/foldoc.cgi?column] if the
database is considered as a table with records
being rows, see " key field [http://foldoc.org/
foldoc/foldoc.cgi Zkey+field] "). Alternatively the
key may be obtained by applying some function,
eg. a hash function [http://foldoc.org/foldoc/
foldoc.cgi7hash+function] , to one or more of the
fields. The set of keys for al records forms an
index [http://foldoc.org/foldoc/foldoc.cgi?index] .
Multiple indices may be built for one database
depending on how it is to be searched.

Primary key

The candidate key [http://foldoc.org/foldoc/
foldoc.cgi?candidatetkey] selected as being most
important for identifying a body of information (an
entity, object or record [http://foldoc.org/foldoc/
foldoc.cgi?record] ).

Record (row)

One or more structured sets of persistent data,
usually associated with software to update and
query [http://foldoc.org/foldoc/foldoc.cgi?query]
the data. A simple database might be a single
file containing many records [http://foldoc.org/
foldoc/foldoc.cgi?records] , each of which contains
the same set of fields [http://foldoc.org/foldoc/
foldoc.cgi ?fields] where each field is a certain fixed
width.

Originally SEQUEL [http://en.wikipedia.org/wiki/
SQL#History] and till pronounced that way by
many practitioners, SQL is the Standard Query
Language; a unified language for creating queries
that isaccepted (with somevariations) by all modern
relational databases.

Table

A collection of records [http://foldoc.org/foldoc/
foldoc.cgi?records] in a relational database [http://
foldoc.org/foldoc/foldoc.cgi ?rel ational +database] .
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Chapter 14. Appendices
Appendix A: GNU GPL Version 3

The Power* Architect is distributed under the terms of the GNU General Public License, version 3 or later.
Hereisthetext of that license:

GNU Genera Public License version 3
Version 3, 29 June 2007
Copyright © 2007 Free Software Foundation, Inc. http://fsf.org/

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it
is not allowed.

Preamble
The GNU General Public Licenseisafree, copyleft license for software and other kinds of works.

Thelicenses for most software and other practical works are designed to take away your freedom to share
and change theworks. By contrast, the GNU General Public Licenseisintended to guarantee your freedom
to share and change all versions of a program—to make sure it remains free software for all its users. We,
the Free Software Foundation, use the GNU General Public License for most of our software; it applies
also to any other work released this way by its authors. Y ou can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are
designed to make sure that you have the freedom to distribute copies of free software (and charge for them
if you wish), that you receive source code or can get it if you want it, that you can change the software or
use pieces of it in new free programs, and that you know you can do these things.

To protect your rights, we need to prevent others from denying you these rights or asking you to surrender
the rights. Therefore, you have certain responsibilities if you distribute copies of the software, or if you
modify it: responsibilities to respect the freedom of others.

For example, if you distribute copies of such a program, whether gratis or for afee, you must pass on to
the recipients the same freedoms that you received. Y ou must make sure that they, too, receive or can get
the source code. And you must show them these terms so they know their rights.

Developersthat use the GNU GPL protect your rights with two steps: (1) assert copyright on the software,
and (2) offer you this License giving you legal permission to copy, distribute and/or modify it.

For the developers' and authors' protection, the GPL clearly explains that there is no warranty for this
free software. For both users' and authors' sake, the GPL requires that modified versions be marked as
changed, so that their problems will not be attributed erroneously to authors of previous versions.

Some devices are designed to deny users access to install or run modified versions of the software inside
them, although the manufacturer can do so. Thisisfundamentally incompatible with the aim of protecting
users’ freedom to change the software. The systematic pattern of such abuse occursin the area of products
for individuals to use, which is precisely where it is most unacceptable. Therefore, we have designed this
version of the GPL to prohibit the practice for those products. If such problems arise substantially in other
domains, we stand ready to extend this provision to those domainsin future versions of the GPL , as needed
to protect the freedom of users.
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Finally, every program is threatened constantly by software patents. States should not allow patents to
restrict development and use of software on general-purpose computers, but in those that do, we wish to
avoid the specia danger that patents applied to a free program could make it effectively proprietary. To
prevent this, the GPL assures that patents cannot be used to render the program non-free.

The precise terms and conditions for copying, distribution and modification follow.
TERMS AND CONDITIONS

0. Definitions.

“This License” refersto version 3 of the GNU General Public License.

“Copyright” also means copyright-like laws that apply to other kinds of works, such as semiconductor
masks.

“The Program” refers to any copyrightable work licensed under this License. Each licensee is addressed
as“you”. “Licensees’ and “recipients’ may beindividuals or organizations.

To “modify” awork means to copy from or adapt all or part of the work in a fashion requiring copyright
permission, other than the making of an exact copy. The resulting work is called a“modified version” of
the earlier work or awork “based on” the earlier work.

A “covered work” means either the unmodified Program or awork based on the Program.

To “propagate” awork means to do anything with it that, without permission, would make you directly
or secondarily liable for infringement under applicable copyright law, except executing it on a computer
or modifying a private copy. Propagation includes copying, distribution (with or without modification),
making available to the public, and in some countries other activities as well.

To “convey” awork means any kind of propagation that enables other parties to make or receive copies.
Mere interaction with a user through a computer network, with no transfer of a copy, is not conveying.

An interactive user interface displays “Appropriate Legal Notices’ to the extent that it includes a
convenient and prominently visible feature that (1) displays an appropriate copyright notice, and (2) tells
the user that there is no warranty for the work (except to the extent that warranties are provided), that
licensees may convey the work under this License, and how to view acopy of thisLicense. If theinterface
presentsalist of user commandsor options, such asamenu, aprominent iteminthelist meetsthiscriterion.

1. Source Code.

The“source code” for awork meansthe preferred form of the work for making modificationstoit. “ Object
code” means any non-source form of awaork.

A “Standard Interface” means an interface that either is an official standard defined by a recognized
standards body, or, in the case of interfaces specified for a particular programming language, one that is
widely used among developers working in that language.

The“System Libraries’ of an executable work include anything, other than the work as a whole, that (a)
is included in the norma form of packaging a Major Component, but which is not part of that Major
Component, and (b) serves only to enable use of the work with that Major Component, or to implement a
Standard Interface for which an implementation is available to the public in source code form. A “Major
Component”, in this context, means a major essential component (kernel, window system, and so on) of
the specific operating system (if any) on which the executable work runs, or a compiler used to produce
the work, or an object code interpreter used to run it.

The“Corresponding Source” for awork in object code form means all the source code needed to generate,
install, and (for an executable work) run the object code and to modify thework, including scriptsto control
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those activities. However, it does not include the work’s System Libraries, or general-purpose tools or
generally available free programs which are used unmodified in performing those activities but which are
not part of thework. For example, Corresponding Source includesinterface definition files associated with
source files for the work, and the source code for shared libraries and dynamically linked subprograms
that the work is specifically designed to require, such as by intimate data communication or control flow
between those subprograms and other parts of the work.

The Corresponding Source need not include anything that users can regenerate automatically from other
parts of the Corresponding Source.

The Corresponding Source for awork in source code form is that same work.
2. Basic Permissions.

All rights granted under this License are granted for the term of copyright on the Program, and are
irrevocable provided the stated conditions are met. This License explicitly affirms your unlimited
permission to run the unmodified Program. The output from running a covered work is covered by this
License only if the output, given its content, constitutes a covered work. This License acknowledges your
rights of fair use or other equivalent, as provided by copyright law.

Y ou may make, run and propagate covered works that you do not convey, without conditions so long as
your license otherwise remains in force. You may convey covered works to others for the sole purpose
of having them make modifications exclusively for you, or provide you with facilities for running those
works, provided that you comply with the terms of this License in conveying all material for which you
do not control copyright. Those thus making or running the covered works for you must do so exclusively
on your behalf, under your direction and control, on terms that prohibit them from making any copies of
your copyrighted material outside their relationship with you.

Conveying under any other circumstances is permitted solely under the conditions stated below.
Sublicensing is not alowed; section 10 makes it unnecessary.

3. Protecting Users' Legal Rights From Anti-Circumvention Law.

No covered work shall be deemed part of an effective technological measure under any applicable law
fulfilling obligations under article 11 of the WIPO copyright treaty adopted on 20 December 1996, or
similar laws prohibiting or restricting circumvention of such measures.

When you convey a covered work, you waive any legal power to forbid circumvention of technological
measures to the extent such circumvention is effected by exercising rights under this License with respect
to the covered work, and you disclaim any intention to limit operation or modification of the work as a
means of enforcing, against the work’s users, your or third parties legal rights to forbid circumvention
of technological measures.

4. Conveying Verbatim Copies.

Y ou may convey verbatim copies of the Program’ s source code as you receiveit, in any medium, provided
that you conspicuously and appropriately publish on each copy an appropriate copyright notice; keep intact
all notices stating that this License and any non-permissive terms added in accord with section 7 apply
to the code; keep intact al notices of the absence of any warranty; and give all recipients a copy of this
License along with the Program.

Y ou may chargeany price or no pricefor each copy that you convey, and you may offer support or warranty
protection for afee.

5. Conveying Modified Source Versions.
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You may convey awork based on the Program, or the modifications to produce it from the Program, in
the form of source code under the terms of section 4, provided that you also meet all of these conditions:

a. Thework must carry prominent notices stating that you modified it, and giving arelevant date.

b. Thework must carry prominent notices stating that it is released under this License and any conditions
added under section 7. This requirement modifies the requirement in section 4 to “keep intact all
notices’.

¢. You must license the entire work, as awhole, under this License to anyone who comes into possession
of acopy. This License will therefore apply, along with any applicable section 7 additional terms, to
the whole of the work, and all its parts, regardless of how they are packaged. This License gives no
permission to license the work in any other way, but it does not invalidate such permission if you have
separately received it.

d. If the work has interactive user interfaces, each must display Appropriate Legal Notices, however, if
the Program has interactive interfaces that do not display Appropriate Legal Notices, your work need
not make them do so.

A compilation of acovered work with other separate and independent works, which are not by their nature
extensions of the covered work, and which are not combined with it such as to form a larger program,
in or on avolume of a storage or distribution medium, is called an “aggregate” if the compilation and its
resulting copyright are not used to limit the access or legal rights of the compilation’ s users beyond what
the individual works permit. Inclusion of a covered work in an aggregate does not cause this License to
apply to the other parts of the aggregate.

6. Conveying Non-Source Forms.

You may convey a covered work in object code form under the terms of sections 4 and 5, provided that
you also convey the machine-readable Corresponding Source under the terms of this License, in one of
these ways:

a. Convey the object code in, or embodied in, a physical product (including a physical distribution
medium), accompanied by the Corresponding Source fixed on a durable physical medium customarily
used for software interchange.

b. Convey the object code in, or embodied in, a physical product (including a physical distribution
medium), accompanied by awritten offer, valid for at |east three yearsand valid for aslong asyou offer
spare parts or customer support for that product model, to give anyone who possesses the object code
either (1) acopy of the Corresponding Source for all the software in the product that is covered by this
License, on adurable physical medium customarily used for software interchange, for a price no more
than your reasonable cost of physically performing this conveying of source, or (2) access to copy the
Corresponding Source from a network server at no charge.

c. Convey individual copies of the object code with a copy of the written offer to provide the
Corresponding Source. Thisalternative is allowed only occasionally and noncommercially, and only if
you received the object code with such an offer, in accord with subsection 6b.

d. Convey the object code by offering access from a designated place (gratis or for a charge), and offer
equivalent access to the Corresponding Source in the same way through the same place at no further
charge. Y ou need not require recipients to copy the Corresponding Source along with the object code.
If the place to copy the object code is a network server, the Corresponding Source may be on a
different server (operated by you or athird party) that supports equivalent copying facilities, provided
you maintain clear directions next to the object code saying where to find the Corresponding Source.
Regardless of what server hosts the Corresponding Source, you remain obligated to ensure that it is
available for as long as needed to satisfy these requirements.
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e. Convey the object code using peer-to-peer transmission, provided you inform other peers where the
object code and Corresponding Source of the work are being offered to the general public at no charge
under subsection 6d.

A separable portion of the object code, whose source code is excluded from the Corresponding Source as
a System Library, need not be included in conveying the object code work.

A “User Product” is either (1) a“consumer product”, which means any tangible personal property which
is normally used for personal, family, or household purposes, or (2) anything designed or sold for
incorporation into a dwelling. In determining whether a product is a consumer product, doubtful cases
shall be resolved in favor of coverage. For a particular product received by a particular user, “normally
used” refersto atypical or common use of that class of product, regardless of the status of the particular
user or of the way in which the particular user actually uses, or expects or is expected to use, the product.
A product is aconsumer product regardless of whether the product has substantial commercial, industrial
or non-consumer uses, unless such uses represent the only significant mode of use of the product.

“Installation Information” for aUser Product means any methods, procedures, authorization keys, or other
information required to install and execute modified versions of a covered work in that User Product
from a modified version of its Corresponding Source. The information must suffice to ensure that the
continued functioning of the modified object code isin no case prevented or interfered with solely because
modification has been made.

If you convey an object code work under this section in, or with, or specifically for usein, a User Product,
and the conveying occurs as part of a transaction in which the right of possession and use of the User
Product is transferred to the recipient in perpetuity or for afixed term (regardless of how the transaction
is characterized), the Corresponding Source conveyed under this section must be accompanied by the
Installation Information. But this requirement does not apply if neither you nor any third party retainsthe
ability to install modified object code on the User Product (for example, the work has been installed in
ROM ).

The requirement to provide Installation Information does not include arequirement to continue to provide
support service, warranty, or updates for awork that has been modified or installed by the recipient, or for
the User Product in which it has been modified or installed. Access to a network may be denied when the
modification itself materially and adversely affects the operation of the network or violates the rules and
protocols for communication across the network.

Corresponding Source conveyed, and Installation Information provided, in accord with this section must
bein aformat that is publicly documented (and with an implementation available to the public in source
code form), and must require no special password or key for unpacking, reading or copying.

7. Additional Terms.

“Additional permissions’ are terms that supplement the terms of this License by making exceptions from
one or more of its conditions. Additional permissions that are applicable to the entire Program shall be
treated as though they wereincluded in this License, to the extent that they are valid under applicable law.
If additional permissions apply only to part of the Program, that part may be used separately under those
permissions, but the entire Program remains governed by this License without regard to the additional
permissions.

When you convey a copy of a covered work, you may at your option remove any additional permissions
fromthat copy, or from any part of it. (Additional permissions may bewritten to requiretheir own removal
in certain cases when you modify the work.) Y ou may place additional permissions on material, added by
you to a covered work, for which you have or can give appropriate copyright permission.

Notwithstanding any other provision of this License, for material you add to a covered work, you may (if
authorized by the copyright holders of that material) supplement the terms of this License with terms:
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a. Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this
License; or

b. Requiring preservation of specified reasonable legal notices or author attributionsin that material or in
the Appropriate Legal Notices displayed by works containing it; or

c. Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such
material be marked in reasonable ways as different from the original version; or

d. Limiting the use for publicity purposes of names of licensors or authors of the material; or

e. Declining to grant rights under trademark law for use of some trade names, trademarks, or service
marks; or

f. Requiring indemnification of licensors and authors of that material by anyonewho conveysthe material
(or modified versions of it) with contractual assumptions of liability to the recipient, for any liability
that these contractual assumptions directly impose on those licensors and authors.

All other non-permissive additional terms are considered “further restrictions’ within the meaning of
section 10. If the Program asyou received it, or any part of it, contains anotice stating that it isgoverned by
thisLicense along with aterm that isafurther restriction, you may removethat term. If alicense document
contains a further restriction but permits relicensing or conveying under this License, you may add to a
covered work material governed by the terms of that license document, provided that the further restriction
does not survive such relicensing or conveying.

If you add terms to a covered work in accord with this section, you must place, in the relevant source
files, a statement of the additional terms that apply to those files, or a notice indicating where to find the
applicable terms.

Additional terms, permissive or non-permissive, may be stated in the form of a separately written license,
or stated as exceptions; the above requirements apply either way.

8. Termination.

Y ou may not propagate or modify a covered work except as expressly provided under this License. Any
attempt otherwise to propagate or modify it isvoid, and will automatically terminate your rights under this
License (including any patent licenses granted under the third paragraph of section 11).

However, if you cease al violation of this License, then your license from a particular copyright holder
isreinstated (a) provisionally, unless and until the copyright holder explicitly and finally terminates your
license, and (b) permanently, if the copyright holder failsto notify you of the violation by some reasonable
means prior to 60 days after the cessation.

Moreover, your license from aparticular copyright holder isreinstated permanently if the copyright holder
notifies you of the violation by some reasonable means, this is the first time you have received notice of
violation of this License (for any work) from that copyright holder, and you cure the violation prior to 30
days after your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received
copies or rights from you under this License. If your rights have been terminated and not permanently
reinstated, you do not qualify to receive new licenses for the same material under section 10.

9. Acceptance Not Required for Having Copies.

You are not required to accept this License in order to receive or run a copy of the Program. Ancillary
propagation of a covered work occurring solely as a consequence of using peer-to-peer transmission to
receive a copy likewise does not require acceptance. However, nothing other than this License grants you
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permission to propagate or modify any covered work. These actionsinfringe copyright if you do not accept
this License. Therefore, by modifying or propagating a covered work, you indicate your acceptance of
this License to do so.

10. Automatic Licensing of Downstream Recipients.

Each time you convey a covered work, the recipient automatically receives a license from the original
licensors, to run, modify and propagate that work, subject to this License. You are not responsible for
enforcing compliance by third parties with this License.

An “entity transaction” is a transaction transferring control of an organization, or substantially all assets
of one, or subdividing an organization, or merging organizations. If propagation of a covered work results
from an entity transaction, each party to that transaction who receives a copy of the work also receives
whatever licenses to the work the party’s predecessor in interest had or could give under the previous
paragraph, plus a right to possession of the Corresponding Source of the work from the predecessor in
interest, if the predecessor hasit or can get it with reasonable efforts.

You may not impose any further restrictions on the exercise of the rights granted or affirmed under this
License. For example, you may not impose a license fee, royalty, or other charge for exercise of rights
granted under this License, and you may not initiate litigation (including a cross-claim or counterclaim
in a lawsuit) aleging that any patent claim is infringed by making, using, selling, offering for sale, or
importing the Program or any portion of it.

11. Patents.

A “contributor” is a copyright holder who authorizes use under this License of the Program or awork on
which the Program is based. The work thus licensed is called the contributor’s “ contributor version”.

A contributor’s “essential patent claims’ are all patent claims owned or controlled by the contributor,
whether already acquired or hereafter acquired, that would be infringed by some manner, permitted by
this License, of making, using, or selling its contributor version, but do not include claims that would
be infringed only as a consequence of further modification of the contributor version. For purposes of
this definition, “control” includes the right to grant patent sublicenses in a manner consistent with the
requirements of this License.

Each contributor grantsyou anon-exclusive, worldwide, royalty-free patent license under the contributor’ s
essential patent claims, to make, use, sell, offer for sale, import and otherwise run, modify and propagate
the contents of its contributor version.

In the following three paragraphs, a “patent license” is any express agreement or commitment, however
denominated, not to enforce a patent (such as an express permission to practice a patent or covenant not to
sue for patent infringement). To “grant” such a patent license to a party means to make such an agreement
or commitment not to enforce a patent against the party.

If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of
the work is not available for anyone to copy, free of charge and under the terms of this License, through
a publicly available network server or other readily accessible means, then you must either (1) cause
the Corresponding Source to be so available, or (2) arrange to deprive yourself of the benefit of the
patent license for this particular work, or (3) arrange, in a manner consistent with the requirements of
this License, to extend the patent license to downstream recipients. “Knowingly relying” meansyou have
actual knowledge that, but for the patent license, your conveying the covered work in a country, or your
recipient’s use of the covered work in a country, would infringe one or more identifiable patents in that
country that you have reason to believe are valid.

If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by
procuring conveyance of, a covered work, and grant a patent license to some of the parties receiving the
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covered work authorizing them to use, propagate, modify or convey a specific copy of the covered work,
then the patent license you grant is automatically extended to all recipients of the covered work and works
based on it.

A patent license is “discriminatory” if it does not include within the scope of its coverage, prohibits the
exercise of, or is conditioned on the non-exercise of one or more of the rights that are specifically granted
under this License. Y ou may not convey acovered work if you are a party to an arrangement with athird
party that is in the business of distributing software, under which you make payment to the third party
based on the extent of your activity of conveying thework, and under which thethird party grants, to any of
the partieswho would receive the covered work from you, adiscriminatory patent license (a) in connection
with copies of the covered work conveyed by you (or copies made from those copies), or (b) primarily
for and in connection with specific products or compilations that contain the covered work, unless you
entered into that arrangement, or that patent license was granted, prior to 28 March 2007.

Nothing in this License shall be construed as excluding or limiting any implied license or other defenses
to infringement that may otherwise be available to you under applicable patent law.

12. No Surrender of Others Freedom.

If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the
conditions of thisLicense, they do not excuse you from the conditions of thisLicense. If you cannot convey
acovered work so asto satisfy simultaneously your obligations under this License and any other pertinent
obligations, then as a consequence you may not convey it at all. For example, if you agree to terms that
obligate you to collect a royalty for further conveying from those to whom you convey the Program, the
only way you could satisfy both those terms and this License would be to refrain entirely from conveying
the Program.

13. Use with the GNU Affero General Public License.

Notwithstanding any other provision of this License, you have permission to link or combine any covered
work with a work licensed under version 3 of the GNU Affero General Public License into a single
combined work, and to convey the resulting work. The terms of this License will continue to apply to the
part which is the covered work, but the special requirements of the GNU Affero General Public License,
section 13, concerning interaction through a network will apply to the combination as such.

14. Revised Versions of this License.

The Free Software Foundation may publish revised and/or new versions of the GNU General Public
Licensefrom timeto time. Such new versionswill be similar in spirit to the present version, but may differ
in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies that a certain numbered
version of the GNU Genera Public License “or any later version” applies to it, you have the option of
following the terms and conditions either of that numbered version or of any later version published by the
Free Software Foundation. If the Program does not specify a version number of the GNU General Public
License, you may choose any version ever published by the Free Software Foundation.

If the Program specifiesthat a proxy can decide which future versions of the GNU General Public License
can be used, that proxy’ s public statement of acceptance of aversion permanently authorizesyou to choose
that version for the Program.

L ater licenseversionsmay giveyou additional or different permissions. However, no additional obligations
are imposed on any author or copyright holder as aresult of your choosing to follow alater version.

15. Disclaimer of Warranty.
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THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY
APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT
HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM “AS IS’ WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF
THE PROGRAM ISWITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME
THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. Limitation of Liability.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS
THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING
ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF
THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS
OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU
OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER
PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

17. Interpretation of Sections 15 and 16.

If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect
according to their terms, reviewing courts shall apply local law that most closely approximates an absolute
waiver of al civil liability in connection with the Program, unless a warranty or assumption of liability
accompanies a copy of the Program in return for afee.

END OF TERMS AND CONDITIONS
How to Apply These Termsto Your New Programs

If you develop anew program, and you want it to be of the greatest possible use to the public, the best way
to achieve thisis to make it free software which everyone can redistribute and change under these terms.

To do so, attach the following noticesto the program. It is safest to attach them to the start of each source
file to most effectively state the exclusion of warranty; and each file should have at least the “ copyright”
line and a pointer to where the full notice is found.

one line to give the progranis name and a brief idea of what it does.
Copyright (C) year nane of aut hor

This program isfree software; you can redistribute it and/or modify it under the terms of the GNU General
Public License as published by the Free Software Foundation, either version 3 of the License, or (at your
option) any later version.

Thisprogram isdistributed in the hope that it will be useful, but WITHOUT ANY WARRANTY ; without
even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.
See the GNU General Public License for more details.

Y ou should have received a copy of the GNU General Public License along with this program. If not, see
http://www.gnu.org/licenses/ [http://www.gnu.org/licenses/] .

Also add information on how to contact you by electronic and paper mail.

If the program does terminal interaction, make it output a short notice like this when it starts in an
interactive mode:
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pr ogr amCopyright (C) year name of aut hor This program comes with ABSOLUTELY NO
WARRANTY; for detailstype* show w'. Thisis free software, and you are welcome to redistribute it
under certain conditions; type‘ show ¢ ’ for details.

The hypothetical commands*® show w’ and* show ¢ ’ should show the appropriate parts of the General
Public License. Of course, your program’s commands might be different; for a GUI interface, you would
use an “about box”.

Y ou should also get your employer (if you work as a programmer) or school, if any, to sign a*copyright
disclaimer” for the program, if necessary. For more information on this, and how to apply and follow the
GNU GPL , see http://www.gnu.org/licenses/ [http://www.gnu.org/licenses/] .

The GNU General Public License does not permit incorporating your program into proprietary programs.
If your program is a subroutine library, you may consider it more useful to permit linking proprietary
applications with the library. If thisis what you want to do, use the GNU Lesser General Public License
instead of this License. But first, please read http://www.gnu.org/philosophy/why-not-Igpl.html [http:/
www.gnu.org/philosophy/why-not-lgpl.html] .

Appendix B: Third Party Licenses
The FAMFAMFAM Silk Icon Set

The Power* Architect development team is grateful to Mark James for the beautiful Silk icon set whichis
used extensively throughout Power* Architect's user interface.

The Silk icons are freely available under the Creative Commons Attribution 2.5 License [http://
creativecommons.org/licenses/by/2.5/] . If youwant to use theseiconsin your ownwork (and why wouldn't
you?), you can obtain the full set from the FAMFAMFAM web site [http://www.famfamfam.com/lab/
icong/silk/] .

The Apache Software Foundation

The Power* Architect development team is grateful to the Apache Software Foundation and their
contributors; their high-quality reusable Java libraries have been invaluable in the development of
Power* Architect. The text of the Apache License follows, because we are redistributing several Apache
libraries upon which Power* Architect depends.

Thefollowing license appliesto theselibrary jar files, which are distributed as part of the Power* Architect
download:

e commons-beanutils.jar

e commons-digester.jar

e commons-logging.jar

» commons-beanutils-bean-collections.jar
» commons-beanutils-corejar

o jakartaregexp-l.2.jar

» commons-collections-3.1.jar

e commons-dbcp-1.2.1.jar
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e commons-pool-1.3.jar

e commons-vfs-1.0.jar

* logdj.jar

» opencsv-1.8.jar

Apache License Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION
1. Definitions.

"License" shall mean thetermsand conditionsfor use, reproduction, and distribution as defined by Sections
1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control” means (i)
the power, direct or indirect, to cause the direction or management of such entity, whether by contract or
otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficia
ownership of such entity.

"You" (or Y our") shall mean anindividual or Legal Entity exercising permissionsgranted by thisLicense.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or trandlation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the
License, as indicated by a copyright notice that is included in or attached to the work (an example is
provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived
from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications
represent, as awhole, an original work of authorship. For the purposes of this License, Derivative Works
shall not include works that remain separable from, or merely link (or bind by name) to the interfaces of,
the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to
Licensor for inclusioninthe Work by the copyright owner or by anindividual or Legal Entity authorized to
submit on behalf of the copyright owner. For the purposes of this definition, "submitted" means any form
of electronic, verbal, or written communication sent to the Licensor or its representatives, including but
not limited to communication on electronic mailing lists, source code control systems, and issue tracking
systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and improving
the Work, but excluding communication that is conspicuously marked or otherwise designated in writing
by the copyright owner as "Not a Contribution."
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"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to thetermsand conditions of thisLicense, each Contributor hereby
grantsto Y ou aperpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license
to reproduce, prepare Derivative Works of, publicly display, publicly perform, sublicense, and distribute
the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License . Subject to the terms and conditions of this License, each Contributor hereby
grantsto Y ou aperpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated
in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise transfer
the Work, where such license applies only to those patent claims licensable by such Contributor that are
necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) with the
Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity
(including across-claim or counterclaimin alawsuit) alleging that the Work or a Contribution incorporated
within the Work constitutes direct or contributory patent infringement, then any patent licenses granted to
Y ou under this License for that Work shall terminate as of the date such litigation isfiled.

4. Redistribution . Y ou may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that Y ou meet the
following conditions:

» You must give any other recipients of the Work or Derivative Works a copy of this License; and
 You must cause any modified filesto carry prominent notices stating that Y ou changed the files; and

* You must retain, in the Source form of any Derivative Works that Y ou distribute, all copyright, patent,
trademark, and attribution notices from the Source form of the Work, excluding those notices that do
not pertain to any part of the Derivative Works; and

« If the Work includes a"NOTICE" text file as part of its distribution, then any Derivative Works that
Y ou distribute must include a readable copy of the attribution notices contained within such NOTICE
file, excluding those notices that do not pertain to any part of the Derivative Works, in at least one of
the following places. within a NOTICE text file distributed as part of the Derivative Works; within
the Source form or documentation, if provided along with the Derivative Works; or, within a display
generated by the Derivative Works, if and wherever such third-party notices normally appear. The
contents of the NOTICE file are for informational purposes only and do not modify the License. You
may add Y our own attribution notices within Derivative Works that Y ou distribute, alongside or as an
addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot
be construed as modifying the License.

Y oumay add Y our own copyright statement to Y our modificationsand may provide additional or different
license terms and conditions for use, reproduction, or distribution of Y our modifications, or for any such
Derivative Works as a whole, provided Y our use, reproduction, and distribution of the Work otherwise
complies with the conditions stated in this License.

5. Submission of Contributions . Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions. Notwithstanding the above, nothing herein shall
supersede or modify the terms of any separate license agreement you may have executed with Licensor
regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service marks,
or product names of the Licensor, except as required for reasonable and customary use in describing the
origin of the Work and reproducing the content of the NOTICE file.
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7. Disclaimer of Warranty . Unless required by applicable law or agreed to in writing, Licensor
provides the Work (and each Contributor provides its Contributions) on an "AS IS' BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Y our exercise
of permissions under this License.

8. Limitation of Liability . In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts)
or agreed to in writing, shall any Contributor be liable to Y ou for damages, including any direct, indirect,
special, incidental, or consequential damages of any character arising as a result of this License or out
of the use or inability to use the Work (including but not limited to damages for loss of goodwill, work
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if
such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability . While redistributing the Work or Derivative Works

thereof, Y ou may chooseto offer, and charge afeefor, acceptance of support, warranty, indemnity, or other
liahility obligationsand/or rights consistent with thisLicense. However, in accepting such obligations, Y ou
may act only on Y our own behalf and on Y our sole responsibility, not on behalf of any other Contributor,
and only if Y ou agree to indemnify, defend, and hold each Contributor harmless for any liability incurred
by, or claims asserted against, such Contributor by reason of your accepting any such warranty or additional
ligbility.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work

To apply the Apache Licenseto your work, attach the following boilerplate notice, with thefields enclosed
by brackets "[]" replaced with your own identifying information. (Don't include the brackets!) The text
should be enclosed in the appropriate comment syntax for the file format. We also recommend that afile
or class name and description of purpose be included on the same "printed page" as the copyright notice
for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner] Licensed
under the Apache License, Version 2.0 (the "License"); you may not
use this file except in compliance with the License. Y ou may obtain
acopy of the License at http://www.apache.org/licenses/LI CENSE-2.0
Unless required by applicable law or agreed to in writing, software
distributed under the Licenseis distributed on an "AS |S" BASIS,
WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or
implied. See the License for the specific language governing
permissions and limitations under the License.

JGoodies Karsten Lentzsch

The Power* Architect team isalso grateful to JGoodiesfor their excellent formslayout manager for Swing.
JGoodies formsis released under the BSD license, reproduced below.

Thefollowing license appliesto theselibrary jar files, which are distributed as part of the Power* Architect
downl oad:

« forms-1.2.1jar

The BSD License for the JGoodies Forms
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Copyright (c) 2002-2006 JGoodies Karsten Lentzsch. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

 Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

 Redistributionsin binary form must reproduce the above copyright notice, thislist of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

 Neither the name of JGoodies Karsten Lentzsch nor the names of its contributors may be used to endorse
or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;, LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

PostgreSQL JDBC Driver

The Power* Architect team would like to thank the PostgreSQL JDBC Driver team for their JIDBC driver.

Thefollowing license appliesto theselibrary jar files, which are distributed as part of the Power* Architect
downl oad:

 postgresgl_8.jar
Copyright (c) 1997-2005, PostgreSQL Global Development Group. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of the PostgreSQL Global Development Group nor the names of its contributors
may be used to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
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I Text

PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;, LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The Power* Architect team is also grateful to Bruno Lowagie and Paulo Soares for their excellent Java
PDF library. iText isreleased under the MPL license, reproduced below.

Thefollowing license appliesto theselibrary jar files, which are distributed as part of the Power* Architect
download:

* itext-2.0.8jar
MOZILLA PUBLIC LICENSE Version 1.1
1. Definitions.

1.0.1. "Commercial Use" means distribution or otherwise making the Covered Code available to a third
party.

1.1. "Contributor" means each entity that creates or contributes to the creation of Modifications.

1.2. "Contributor Version" means the combination of the Original Code, prior Modifications used by a
Contributor, and the Modifications made by that particular Contributor.

1.3. "Covered Code" means the Original Code or Modifications or the combination of the Original Code
and Modifications, in each case including portions thereof.

1.4. "Electronic Distribution Mechanism" means a mechanism generally accepted in the software
development community for the electronic transfer of data.

1.5. "Executable" means Covered Code in any form other than Source Code.

1.6. "Initial Developer" means the individual or entity identified as the Initial Developer in the Source
Code notice required by Exhibit A.

1.7. "Larger Work" means a work which combines Covered Code or portions thereof with code not
governed by the terms of this License.

1.8. "License" means this document.

1.8.1. "Licensable" means having the right to grant, to the maximum extent possible, whether at the time
of theinitial grant or subsequently acquired, any and all of the rights conveyed herein.

1.9. "Madifications' means any addition to or deletion from the substance or structure of either the Original
Code or any previous Modifications. When Covered Code is released as a series of files, a Modification
is: A. Any addition to or deletion from the contents of a file containing Origina Code or previous
Modifications.

B. Any new file that contains any part of the Original Code or previous Modifications.

1.10. "Original Code" means Source Code of computer software code which is described in the Source
Code naticerequired by Exhibit A asOriginal Code, and which, at thetime of itsrelease under thisLicense
is not already Covered Code governed by this License.
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1.10.1. "Patent Claims" means any patent claim(s), now owned or hereafter acquired, including without
limitation, method, process, and apparatus claims, in any patent Licensable by grantor.

1.11. "Source Code" means the preferred form of the Covered Code for making modifications to it,
including all modules it contains, plus any associated interface definition files, scripts used to control
compilation and installation of an Executable, or source code differential comparisons against either the
Original Code or another well known, available Covered Code of the Contributor's choice. The Source
Code can be in a compressed or archival form, provided the appropriate decompression or de-archiving
software iswidely available for no charge.

1.12."You" (or "Your") meansan individua or alegal entity exercising rights under, and complying with
all of the terms of, this License or a future version of this License issued under Section 6.1. For legd
entities, "Y ou" includes any entity which controls, is controlled by, or is under common control with Y ou.
For purposes of this definition, "control" means (a) the power, direct or indirect, to cause the direction or
management of such entity, whether by contract or otherwise, or (b) ownership of more than fifty percent
(50%) of the outstanding shares or beneficial ownership of such entity.

2. Source Code License.

2.1. The Initial Developer Grant. The Initial Developer hereby grants You a world-wide, royalty-free,
non-exclusive license, subject to third party intellectual property claims: (a) under intellectual property
rights (other than patent or trademark) Licensable by Initial Developer to use, reproduce, modify, display,
perform, sublicense and distribute the Original Code (or portions thereof) with or without Modifications,
and/or as part of aLarger Work; and

(b) under Patents Claimsinfringed by the making, using or selling of Original Code, to make, have made,
use, practice, sell, and offer for sale, and/or otherwise dispose of the Original Code (or portions thereof).

(c) the licenses granted in this Section 2.1(a) and (b) are effective on the date Initial Developer first
distributes Original Code under the terms of this License.

(d) Notwithstanding Section 2.1(b) above, no patent licenseisgranted: 1) for codethat Y ou deletefrom the
Origina Code; 2) separate from the Original Code; or 3) for infringements caused by: i) the modification
of the Original Code or ii) the combination of the Original Code with other software or devices.

2.2. Contributor Grant. Subject to third party intellectua property claims, each Contributor hereby grants
Y ou aworld-wide, royalty-free, non-exclusive license

(8) under intellectual property rights (other than patent or trademark) Licensable by Contributor, to
use, reproduce, modify, display, perform, sublicense and distribute the Modifications created by such
Contributor (or portionsthereof) either on an unmodified basis, with other Modifications, as Covered Code
and/or as part of aLarger Work; and

(b) under Patent Claims infringed by the making, using, or selling of Modifications made by that
Contributor either alone and/or in combination with its Contributor Version (or portions of such
combination), to make, use, sell, offer for sale, have made, and/or otherwise dispose of: 1) Modifications
made by that Contributor (or portions thereof); and 2) the combination of Modifications made by that
Contributor with its Contributor Version (or portions of such combination).

(c) the licenses granted in Sections 2.2(a) and 2.2(b) are effective on the date Contributor first makes
Commercial Use of the Covered Code.

(d) Notwithstanding Section 2.2(b) above, no patent license is granted: 1) for any code that Contributor
has deleted from the Contributor Version; 2) separate from the Contributor Version; 3) for infringements
caused by: i) third party modifications of Contributor Version or ii) the combination of Modifications made
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by that Contributor with other software (except as part of the Contributor Version) or other devices; or 4)
under Patent Claimsinfringed by Covered Codein the absence of Modifications made by that Contributor.

3. Distribution Obligations.

3.1. Application of License. The Modificationswhich Y ou create or to which Y ou contribute are governed
by theterms of this License, including without limitation Section 2.2. The Source Code version of Covered
Code may be distributed only under the terms of this License or a future version of this License released
under Section 6.1, and Y ou must include a copy of this License with every copy of the Source Code Y ou
distribute. You may not offer or impose any terms on any Source Code version that alters or restricts
the applicable version of this License or the recipients' rights hereunder. However, Y ou may include an
additional document offering the additional rights described in Section 3.5.

3.2. Availability of Source Code. Any Modification which Y ou create or to which Y ou contribute must
be made available in Source Code form under the terms of this License either on the same media as an
Executableversion or viaan accepted Electronic Distribution Mechanism to anyone to whom you made an
Executable version available; and if made available via Electronic Distribution Mechanism, must remain
availablefor at least twelve (12) months after thedateit initially became available, or at least six (6) months
after a subsequent version of that particular Modification has been made available to such recipients.
You are responsible for ensuring that the Source Code version remains available even if the Electronic
Distribution Mechanism is maintained by athird party.

3.3. Description of Modifications. Y ou must cause all Covered Code to which Y ou contribute to contain
a file documenting the changes Y ou made to create that Covered Code and the date of any change. You
must include a prominent statement that the Modification is derived, directly or indirectly, from Original
Code provided by the Initial Developer and including the name of the Initial Developer in (a) the Source
Code, and (b) in any notice in an Executable version or related documentation in which Y ou describe the
origin or ownership of the Covered Code.

3.4. Intellectual Property Matters(a) Third Party Claims. If Contributor has knowledge that alicense under
a third party's intellectual property rights is required to exercise the rights granted by such Contributor
under Sections 2.1 or 2.2, Contributor must include a text file with the Source Code distribution titled
"LEGAL" which describesthe claim and the party making the claim in sufficient detail that arecipient will
know whom to contact. If Contributor obtains such knowledge after the Modification is made available
as described in Section 3.2, Contributor shall promptly modify the LEGAL filein all copies Contributor
makes available thereafter and shall take other steps (such as notifying appropriate mailing lists or
newsgroups) reasonably calculated to inform those who received the Covered Code that new knowledge
has been obtained.

(b) Contributor APIs. If Contributor's Modifications include an application programming interface and
Contributor has knowledge of patent licenses which are reasonably necessary to implement that API,
Contributor must also include thisinformation in the LEGAL file.

(c) Representations. Contributor represents that, except as disclosed pursuant to Section 3.4(a) above,
Contributor believes that Contributor's Modifications are Contributor's original creation(s) and/or
Contributor has sufficient rights to grant the rights conveyed by this License.

3.5. Required Notices. Y ou must duplicate the noticein Exhibit A in each file of the Source Code. If itisnot
possibleto put such noticein aparticular Source Codefile dueto its structure, then Y ou must include such
noticein alocation (such asarelevant directory) where auser would be likely to look for such anatice. If
Y ou created one or more Madification(s) Y ou may add your name as a Contributor to the notice described
in Exhibit A. Y ou must also duplicate this License in any documentation for the Source Code where Y ou
describe recipients' rights or ownership rights relating to Covered Code. Y ou may choose to offer, and to
charge afeefor, warranty, support, indemnity or liability obligations to one or more recipients of Covered
Code. However, You may do so only on Your own behalf, and not on behalf of the Initial Developer or
any Contributor. Y ou must make it absolutely clear than any such warranty, support, indemnity or liability
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obligation is offered by You alone, and Y ou hereby agree to indemnify the Initial Developer and every
Contributor for any liability incurred by the Initial Developer or such Contributor as aresult of warranty,
support, indemnity or liability terms Y ou offer.

3.6. Distribution of Executable Versions. You may distribute Covered Code in Executable form only if
the requirements of Section 3.1-3.5 have been met for that Covered Code, and if You include a notice
stating that the Source Code version of the Covered Code is available under the terms of this License,
including a description of how and where Y ou have fulfilled the obligations of Section 3.2. The notice
must be conspicuously included in any noticein an Executable version, rel ated documentation or collateral
in which Y ou describe recipients' rights relating to the Covered Code. Y ou may distribute the Executable
version of Covered Code or ownership rights under a license of Y our choice, which may contain terms
different from this License, provided that Y ou are in compliance with the terms of this License and that the
license for the Executable version does not attempt to limit or alter the recipient'srightsin the Source Code
version from the rights set forth in this License. If Y ou distribute the Executable version under adifferent
license You must make it absolutely clear that any terms which differ from this License are offered by
You aone, not by the Initial Developer or any Contributor. You hereby agree to indemnify the Initial
Developer and every Contributor for any liability incurred by the Initial Developer or such Contributor
as aresult of any such terms Y ou offer.

3.7. Larger Works. You may create a Larger Work by combining Covered Code with other code not
governed by the terms of this License and distribute the Larger Work as a single product. In such a case,
Y ou must make sure the requirements of this License are fulfilled for the Covered Code.

4. Inability to Comply Due to Statute or Regulation.

If itisimpossiblefor Y ou to comply with any of theterms of this License with respect to some or all of the
Covered Code dueto statute, judicial order, or regulation then Y ou must: (a) comply with the terms of this
License to the maximum extent possible; and (b) describe the limitations and the code they affect. Such
description must be included in the LEGAL file described in Section 3.4 and must be included with all
distributions of the Source Code. Except to the extent prohibited by statute or regulation, such description
must be sufficiently detailed for arecipient of ordinary skill to be able to understand it.

5. Application of this License.

This License applies to code to which the Initial Developer has attached the notice in Exhibit A and to
related Covered Code.

6. Versions of the License.

6.1. New Versions. Netscape Communications Corporation ("Netscape") may publish revised and/or new
versions of the License from time to time. Each version will be given a distinguishing version number.

6.2. Effect of New Versions. Once Covered Code has been published under a particular version of the
License, You may always continue to use it under the terms of that version. Y ou may also choose to use
such Covered Code under the terms of any subsequent version of the License published by Netscape. No
one other than Netscape has the right to modify the terms applicable to Covered Code created under this
License.

6.3. Derivative Works. If You create or use a modified version of this License (which you may only do
in order to apply it to code which is not already Covered Code governed by this License), You must
(a) rename Y our license so that the phrases "Mozilla", "MOZILLAPL", "MOZPL", "Netscape", "MPL",
"NPL" or any confusingly similar phrase do not appear in your license (except to note that your license
differs from this License) and (b) otherwise make it clear that Y our version of the license contains terms
which differ from the Mozilla Public License and Netscape Public License. (Filling in the name of the
Initial Developer, Original Code or Contributor inthe notice described in Exhibit A shall not of themselves
be deemed to be modifications of this License.)
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7. DISCLAIMER OF WARRANTY.

COVERED CODE IS PROVIDED UNDER THIS LICENSE ON AN "AS IS' BASIS, WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, WITHOUT
LIMITATION, WARRANTIES THAT THE COVERED CODE |S FREE OF DEFECTS,
MERCHANTABLE, FIT FOR A PARTICULAR PURPOSE OR NON-INFRINGING. THE ENTIRE
RISK AS TO THE QUALITY AND PERFORMANCE OF THE COVERED CODE IS WITH
YOU. SHOULD ANY COVERED CODE PROVE DEFECTIVE IN ANY RESPECT, YOU (NOT
THE INITIAL DEVELOPER OR ANY OTHER CONTRIBUTOR) ASSUME THE COST OF ANY
NECESSARY SERVICING, REPAIR OR CORRECTION. THIS DISCLAIMER OF WARRANTY
CONSTITUTES AN ESSENTIAL PART OF THISLICENSE. NO USE OF ANY COVERED CODE IS
AUTHORIZED HEREUNDER EXCEPT UNDER THIS DISCLAIMER.

8. TERMINATION.

8.1. ThisLicense and therights granted hereunder will terminate automatically if Y ou fail to comply with
terms herein and fail to cure such breach within 30 days of becoming aware of the breach. All sublicenses
to the Covered Code which are properly granted shall survive any termination of this License. Provisions
which, by their nature, must remain in effect beyond the termination of this License shall survive.

8.2. If You initiate litigation by asserting a patent infringement claim (excluding declatory judgment
actions) against Initial Developer or a Contributor (the Initial Developer or Contributor against whom Y ou
file such action isreferred to as "Participant") alleging that:

(a) such Participant's Contributor Version directly or indirectly infringes any patent, then any and all rights
granted by such Participant to You under Sections 2.1 and/or 2.2 of this License shall, upon 60 days
notice from Participant terminate prospectively, unlessif within 60 days after receipt of notice Y ou either:
() agree in writing to pay Participant a mutually agreeable reasonable royalty for Your past and future
use of Madifications made by such Participant, or (ii) withdraw Your litigation claim with respect to
the Contributor Version against such Participant. If within 60 days of notice, a reasonable royalty and
payment arrangement are not mutually agreed upon in writing by the parties or the litigation claim is not
withdrawn, the rights granted by Participant to Y ou under Sections 2.1 and/or 2.2 automatically terminate
at the expiration of the 60 day notice period specified above.

(b) any software, hardware, or device, other than such Participant's Contributor Version, directly or
indirectly infringes any patent, then any rights granted to Y ou by such Participant under Sections 2.1(b)
and 2.2(b) are revoked effective as of the date You first made, used, sold, distributed, or had made,
Modifications made by that Participant.

8.3. If You assert a patent infringement claim against Participant alleging that such Participant's
Contributor Version directly or indirectly infringes any patent where such claim is resolved (such as by
license or settlement) prior to the initiation of patent infringement litigation, then the reasonable value of
thelicenses granted by such Participant under Sections 2.1 or 2.2 shall betaken into account in determining
the amount or value of any payment or license.

8.4. Inthe event of termination under Sections 8.1 or 8.2 above, all end user license agreements (excluding
distributors and resellers) which have been validly granted by You or any distributor hereunder prior to
termination shall survive termination.

9.LIMITATION OF LIABILITY.

UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, WHETHER TORT
(INCLUDING NEGLIGENCE), CONTRACT, OR OTHERWISE, SHALL YOU, THE INITIAL
DEVELOPER, ANY OTHER CONTRIBUTOR, OR ANY DISTRIBUTOR OF COVERED CODE,
OR ANY SUPPLIER OF ANY OF SUCH PARTIES, BE LIABLE TO ANY PERSON FOR
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ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY
CHARACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL,
WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER
COMMERCIAL DAMAGES OR LOSSES, EVEN IF SUCH PARTY SHALL HAVE BEEN
INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. THIS LIMITATION OF LIABILITY
SHALL NOT APPLY TO LIABILITY FOR DEATH OR PERSONAL INJURY RESULTING
FROM SUCH PARTY'S NEGLIGENCE TO THE EXTENT APPLICABLE LAW PROHIBITS SUCH
LIMITATION. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION
OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS EXCLUSION AND LIMITATION
MAY NOT APPLY TO YOU.

10. U.S. GOVERNMENT END USERS.

TheCovered Codeisa"commercia item," asthat termisdefined in 48 C.F.R. 2.101 (Oct. 1995), consisting
of "commercial computer software" and "commercial computer software documentation,” as such terms
are used in 48 C.F.R. 12.212 (Sept. 1995). Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1
through 227.7202-4 (June 1995), all U.S. Government End Users acquire Covered Code with only those
rights set forth herein.

11. MISCELLANEOUS.

This License represents the complete agreement concerning subject matter hereof. If any provision of this
Licenseisheld to be unenforceable, such provision shall be reformed only to the extent necessary to make
it enforceable. ThisLicense shall be governed by Californialaw provisions (except to the extent applicable
law, if any, provides otherwise), excluding its conflict-of-law provisions. With respect to disputesin which
at least one party is acitizen of, or an entity chartered or registered to do business in the United States of
America, any litigation relating to this License shall be subject to the jurisdiction of the Federal Courts
of the Northern District of California, with venue lying in Santa Clara County, California, with the losing
party responsible for costs, including without limitation, court costs and reasonable attorneys' fees and
expenses. The application of the United Nations Convention on Contracts for the International Sale of
Goods is expressly excluded. Any law or regulation which provides that the language of a contract shall
be construed against the drafter shall not apply to this License.

12. RESPONSIBILITY FOR CLAIMS.

As between Initial Developer and the Contributors, each party is responsible for claims and damages
arising, directly or indirectly, out of its utilization of rights under this License and Y ou agree to work with
Initial Developer and Contributors to distribute such responsibility on an equitable basis. Nothing herein
isintended or shall be deemed to constitute any admission of liability.

13. MULTIPLE-LICENSED CODE.

Initial Developer may designate portions of the Covered Code as "Multiple-Licensed”. "Multiple-
Licensed" meansthat the Initial Developer permitsyou to utilize portions of the Covered Code under Y our
choice of the NPL or the alternative licenses, if any, specified by the Initial Developer in the file described
in Exhibit A.

EXHIBIT A -Mozilla Public License.
““The contents of this file are subject to the Mozilla Public License Version 1.1 (the "License"); you

may not use this file except in compliance with the License. You may obtain a copy of the License at
http://www.mozilla.org/MPL/

Software distributed under the License is distributed on an "AS IS" basis, WITHOUT WARRANTY OF
ANY KIND, either express or implied. See the License for the specific language governing rights and
limitations under the License.
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The Original Codeis

The Initia Developer of the Origina Code is . Portions created by
are Copyright (C) . All Rights Reserved.

Contributor(s):

Alternatively, the contents of this file may be used under the terms of the license (the "[___]
License"), in which case the provisions of [ License are applicable instead of those above. If you
wish to alow use of your version of thisfile only under the terms of the[____ ] License and not to allow
others to use your version of this file under the MPL, indicate your decision by deleting the provisions
above and replace them with the notice and other provisions required by the[ ] License. If you do not
delete the provisions above, arecipient may use your version of thisfile under either the MPL orthe[ ]
License."

[NOTE: Thetext of this Exhibit A may differ slightly from the text of the noticesin the Source Codefiles
of the Original Code. Y ou should use the text of this Exhibit A rather than the text found in the Original
Code Source Code for Y our Modifications.]

GNU LGPL version 3

The Power* Architect team isalso grateful to the JFree team for their top-notch charting library, which has
anice APl aswell as nice-looking output.

Thefollowing license appliesto theselibrary jar files, which are distributed as part of the Power* Architect
downl oad:

e jcommon-1.0.0.jar

e jfreechart-1.0.1.jar

* rsyntaxtextareajar

GNU Lesser General Public License version 3

Version 3, 29 June 2007

Copyright © 2007 Free Software Foundation, Inc. http://fsf.org/

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it
is not allowed.

This version of the GNU Lesser General Public License incorporates the terms and conditions of version
3 of the GNU General Public License, supplemented by the additional permissions listed below.

0. Additional Definitions.

As used herein, “this License” refers to version 3 of the GNU Lesser General Public License, and the “
GNU GPL " refersto version 3 of the GNU Genera Public License.

“TheLibrary” refersto acovered work governed by this License, other than an Application or aCombined
Work as defined below.

An “Application” is any work that makes use of an interface provided by the Library, but which is not
otherwise based on the Library. Defining a subclass of a class defined by the Library is deemed a mode
of using an interface provided by the Library.
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A “Combined Work” is awork produced by combining or linking an Application with the Library. The
particular version of the Library with which the Combined Work was made is also called the “Linked
Version”.

The “Minimal Corresponding Source” for a Combined Work means the Corresponding Source for the
Combined Work, excluding any source code for portions of the Combined Work that, considered in
isolation, are based on the Application, and not on the Linked Version.

The “Corresponding Application Code” for a Combined Work means the object code and/or source code
for the Application, including any data and utility programs needed for reproducing the Combined Work
from the Application, but excluding the System Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL .

You may convey a covered work under sections 3 and 4 of this License without being bound by section
3 of the GNU GPL .

2. Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a function or data to
be supplied by an Application that uses the facility (other than as an argument passed when the facility is
invoked), then you may convey a copy of the modified version:

a. under thisLicense, provided that you make agood faith effort to ensure that, in the event an Application
does not supply the function or data, thefacility still operates, and performswhatever part of its purpose
remains meaningful, or

b. under the GNU GPL , with none of the additional permissions of this License applicable to that copy.
3. Object Code Incorporating Material from Library Header Files.

The object code form of an Application may incorporate material from a header file that is part of the
Library. You may convey such object code under terms of your choice, provided that, if the incorporated
material is not limited to numerical parameters, data structure layouts and accessors, or small macros,
inline functions and templates (ten or fewer lines in length), you do both of the following:

a. Give prominent notice with each copy of the object code that the Library is used in it and that the
Library and its use are covered by this License.

b. Accompany the object code with a copy of the GNU GPL and this license document.
4. Combined Works.

You may convey a Combined Work under terms of your choice that, taken together, effectively do
not restrict modification of the portions of the Library contained in the Combined Work and reverse
engineering for debugging such modifications, if you also do each of the following:

a. Give prominent notice with each copy of the Combined Work that the Library isused in it and that the
Library and its use are covered by this License.

b. Accompany the Combined Work with a copy of the GNU GPL and this license document.

¢. For a Combined Work that displays copyright notices during execution, include the copyright notice
for the Library among these notices, as well as areference directing the user to the copies of the GNU
GPL and this license document.

d. Do one of the following:

87



Appendices

1. Convey the Minimal Corresponding Source under the terms of this License, and the Corresponding
Application Codein aform suitable for, and under terms that permit, the user to recombine or relink
the Application with a modified version of the Linked Version to produce a modified Combined
Work, in the manner specified by section 6 of the GNU GPL for conveying Corresponding Source.

2. Use asuitable shared library mechanism for linking with the Library. A suitable mechanism isone
that (a) uses at run time a copy of the Library already present on the user’s computer system, and
(b) will operate properly with a modified version of the Library that is interface-compatible with
the Linked Version.

e. Provide Ingtallation Information, but only if you would otherwise be required to provide such
information under section 6 of the GNU GPL , and only to the extent that such information is necessary
to install and execute amodified version of the Combined Work produced by recombining or relinking
the Application with amodified version of the Linked Version. (If you use option 4d0, the Installation
Information must accompany the Minimal Corresponding Source and Corresponding Application
Code. If you use option 4d1, you must provide the Installation Information in the manner specified by
section 6 of the GNU GPL for conveying Corresponding Source.)

5. Combined Libraries.

Y oumay placelibrary facilitiesthat are awork based onthe Library sideby sidein asinglelibrary together
with other library facilities that are not Applications and are not covered by this License, and convey such
acombined library under terms of your choice, if you do both of the following:

a. Accompany the combined library with acopy of the same work based on the Library, uncombined with
any other library facilities, conveyed under the terms of this License.

b. Give prominent notice with the combined library that part of it is a work based on the Library, and
explaining where to find the accompanying uncombined form of the same work.

6. Revised Versions of the GNU Lesser General Public License.

The Free Software Foundation may publish revised and/or new versions of the GNU L esser General Public
Licensefrom timeto time. Such new versionswill be similar in spirit to the present version, but may differ
in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library as you received it specifies that a
certain numbered version of the GNU Lesser General Public License “or any later version” appliesto it,
you have the option of following the terms and conditions either of that published version or of any later
version published by the Free Software Foundation. If the Library as you received it does not specify a
version number of the GNU Lesser General Public License, you may choose any version of the GNU
Lesser General Public License ever published by the Free Software Foundation.

If the Library as you received it specifies that a proxy can decide whether future versions of the GNU
Lesser General Public License shall apply, that proxy’s public statement of acceptance of any version is
permanent authorization for you to choose that version for the Library.

JuUnit

The Power* Architect team would a so like to extend our sincere thanksto the JUnit.org team. JUnit forms
an invaluable part of our development process, but it is not redistributed as part of the Power* Architect
download so itslicense is not reproduced here.

If you devel op software, you should become test infected too! Learn about JUnit at http://www.junit.org/
[http://www.junit.org/] .

88


http://www.junit.org/
http://www.junit.org/

Appendices

Pentaho Data Integration

The Power* Architect provides ETL integration features with Pentaho Data Integration (the tool formerly
known as Kettle), and we redistribute a portion of the Kettle library along with the Architect in order to
support those features.

We gratefully acknowlegde the work of Matt Casters and the Pentaho corporation for their support and
hard work on this product.

We redistribute kettle (kettlejar), and edtftpj (edtftpj-1.5.4.jar), an FTP library upon which it depends,
under the terms of the GNU LGPL, which isreproduced in full elsewherein this section.

The Eclipse Foundation

The Power* Architect was primarily developed and tested using the Eclipse [ http://www.eclipse.org/] Java
Development Tools, one of the more productive Java environments around.

Sun Microsystems

Last but not least, many thanks to Sun Microsystems [http://java.sun.com/] and their various Java
development teams for creating, extending, bugfixing, documenting, and supporting the Java platform
over the past N years!

We redistribute the JavaHel p runtime library with Power* Architect. Although the JavaHelp website says
that the system will be redistributable royalty-free, it does not actually link to the specific license terms.
If someone can point usto the license text for JavaHel p redistributions, we would be grateful!

The portion of JavaHelp that we redistributeisin the following JAR file:

e jhaljar

We also redistribute the JavaMail library and the JavaBeans Activation Framework, on which it depends
(Kettle depends on JavaMail).

The following JAR files are covered by the CDDL, reproduced below:

* mail jar

 activation.jar

COMMON DEVELOPMENT AND DISTRIBUTION LICENSE (CDDL) Version 1.0

1. Definitions.

1.1. Contributor meanseach individual or entity that creates or contributesto the creation of Modifications.

1.2. Contributor Version means the combination of the Original Software, prior Modifications used by a
Contributor (if any), and the Modifications made by that particular Contributor.

1.3. Covered Software means (@) the Original Software, or (b) Maodifications, or (c) thecombination of files
containing Original Software with files containing Modifications, in each case including portions thereof.

1.4. Executable means the Covered Software in any form other than Source Code.
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1.5. Initial Developer means the individual or entity that first makes Original Software available under
this License.

1.6. Larger Work means a work which combines Covered Software or portions thereof with code not
governed by the terms of this License.

1.7. License means this document.

1.8. Licensable means having the right to grant, to the maximum extent possible, whether at the time of
theinitial grant or subsequently acquired, any and al of the rights conveyed herein.

1.9. Modifications means the Source Code and Executable form of any of the following: A. Any file that
results from an addition to, deletion from or modification of the contents of a file containing Original
Software or previous Maodifications; B. Any new file that contains any part of the Original Software or
previous Modification; or C. Any new file that is contributed or otherwise made available under the terms
of this License.

1.10. Original Software means the Source Code and Executable form of computer software code that is
originally released under this License.

1.11. Patent Claims means any patent claim(s), now owned or hereafter acquired, including without
limitation, method, process, and apparatus claims, in any patent Licensable by grantor.

1.12. Source Code means (a) the common form of computer software code in which modifications are
made and (b) associated documentation included in or with such code.

1.13. You (or Your) means an individual or alegal entity exercising rights under, and complying with
all of the terms of, this License. For legal entities, Y ou includes any entity which controls, is controlled
by, or is under common control with You. For purposes of this definition, control means (a) the power,
direct or indirect, to cause the direction or management of such entity, whether by contract or otherwise,
or (b) ownership of more than fifty percent (50%) of the outstanding shares or beneficial ownership of
such entity.

2. License Grants.

2.1. Thelnitial Developer Grant. Conditioned upon Y our compliance with Section 3.1 bel ow and subject to
third party intellectual property claims, the Initial Developer hereby grants Y ou aworld-wide, royalty-free,
non-exclusive license:

(a) under intellectual property rights (other than patent or trademark) Licensable by Initial Developer,
to use, reproduce, modify, display, perform, sublicense and distribute the Original Software (or portions
thereof), with or without Modifications, and/or as part of a Larger Work; and

(b) under Patent Claims infringed by the making, using or selling of Original Software, to make, have
made, use, practice, sell, and offer for sale, and/or otherwise dispose of the Original Software (or portions
thereof);

(c) Thelicensesgrantedin Sections 2.1(a) and (b) are effective on thedate Initial Devel oper first distributes
or otherwise makes the Original Software available to athird party under the terms of this License;

(d) Notwithstanding Section 2.1(b) above, no patent license is granted: (1) for code that Y ou delete from
the Original Software, or (2) for infringements caused by: (i) the modification of the Original Software,
or (ii) the combination of the Original Software with other software or devices.

2.2. Contributor Grant. Conditioned upon Y our compliance with Section 3.1 below and subject to third
party intellectual property claims, each Contributor hereby grants You a world-wide, royalty-free, non-
exclusive license:
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(a) under intellectual property rights (other than patent or trademark) Licensable by Contributor to
use, reproduce, modify, display, perform, sublicense and distribute the Modifications created by such
Contributor (or portions thereof), either on an unmodified basis, with other Modifications, as Covered
Software and/or as part of a Larger Work; and

(b) under Patent Claims infringed by the making, using, or selling of Modifications made by that
Contributor either alone and/or in combination with its Contributor Version (or portions of such
combination), to make, use, sell, offer for sale, have made, and/or otherwise dispose of: (1) Modifications
made by that Contributor (or portions thereof); and (2) the combination of Modifications made by that
Contributor with its Contributor Version (or portions of such combination).

(c) Thelicenses granted in Sections 2.2(a) and 2.2(b) are effective on the date Contributor first distributes
or otherwise makes the Modifications available to athird party.

(d) Notwithstanding Section 2.2(b) above, no patent license is granted: (1) for any code that Contributor
has deleted from the Contributor Version; (2) for infringements caused by: (i) third party modifications
of Contributor Version, or (ii) the combination of Modifications made by that Contributor with other
software (except as part of the Contributor Version) or other devices; or (3) under Patent Claimsinfringed
by Covered Software in the absence of Modifications made by that Contributor.

3. Distribution Obligations.

3.1. Availability of Source Code. Any Covered Software that Y ou distribute or otherwise make available
in Executable form must also be made available in Source Code form and that Source Code form must
be distributed only under the terms of this License. Y ou must include a copy of this License with every
copy of the Source Code form of the Covered Software Y ou distribute or otherwise make available. Y ou
must inform recipients of any such Covered Software in Executable form as to how they can obtain such
Covered Software in Source Code form in areasonable manner on or through a medium customarily used
for software exchange.

3.2. Modifications. The Modifications that Y ou create or to which You contribute are governed by the
terms of this License. You represent that You believe Y our Modifications are Your original creation(s)
and/or Y ou have sufficient rights to grant the rights conveyed by this License.

3.3. Required Notices. You must include a notice in each of Your Modifications that identifies You as
the Contributor of the Modification. You may not remove or alter any copyright, patent or trademark
notices contained within the Covered Software, or any notices of licensing or any descriptive text giving
attribution to any Contributor or the Initial Developer.

3.4. Application of Additional Terms. Y ou may not offer or impose any terms on any Covered Software
in Source Code form that alters or restricts the applicable version of this License or the recipients rights
hereunder. Y ou may choose to offer, and to charge a fee for, warranty, support, indemnity or liability
obligations to one or more recipients of Covered Software. However, you may do so only on Y our own
behalf, and not on behalf of the Initial Developer or any Contributor. Y ou must make it absolutely clear
that any such warranty, support, indemnity or liability obligation is offered by Y ou aone, and Y ou hereby
agree to indemnify the Initial Developer and every Contributor for any liability incurred by the Initial
Developer or such Contributor as aresult of warranty, support, indemnity or liability terms Y ou offer.

3.5. Distribution of Executable Versions. Y ou may distribute the Executable form of the Covered Software
under the terms of this License or under the terms of alicense of Y our choice, which may contain terms
different from this License, provided that Y ou are in compliance with the terms of this License and that the
license for the Executable form does not attempt to limit or alter the recipients rights in the Source Code
form from the rights set forth in this License. If Y ou distribute the Covered Software in Executable form
under adifferent license, Y ou must make it absolutely clear that any terms which differ from this License
are offered by You aone, not by the Initial Developer or Contributor. You hereby agree to indemnify
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the Initial Developer and every Contributor for any liability incurred by the Initial Developer or such
Contributor as aresult of any such terms Y ou offer.

3.6. Larger Works. You may create a Larger Work by combining Covered Software with other code not
governed by the terms of this License and distribute the Larger Work as a single product. In such a case,
Y ou must make sure the requirements of this License are fulfilled for the Covered Software.

4. Versions of the License.

4.1. New Versions. Sun Microsystems, Inc. is the initial license steward and may publish revised and/or
new versionsof thisLicensefromtimeto time. Each version will be given adistinguishing version number.
Except asprovided in Section 4.3, no one other than thelicense steward hastheright to modify thisLicense.

4.2. Effect of New Versions. Y ou may always continue to use, distribute or otherwise make the Covered
Software available under the terms of the version of the License under which Y ou originally received the
Covered Software. If the Initial Developer includes a notice in the Original Software prohibiting it from
being distributed or otherwise made available under any subsequent version of the License, You must
distribute and make the Covered Software available under the terms of the version of the License under
which Y ou originally received the Covered Software. Otherwise, Y ou may also chooseto use, distribute or
otherwise make the Covered Software available under the terms of any subsequent version of the License
published by the license steward.

4.3. Modified Versions. When You are an Initial Developer and Y ou want to create a new license for
Your Origina Software, You may create and use a modified version of this License if You: (a) rename
the license and remove any references to the name of the license steward (except to note that the license
differs from this License); and (b) otherwise make it clear that the license contains terms which differ
from this License.

5. DISCLAIMER OF WARRANTY. COVERED SOFTWARE |S PROVIDED UNDER THIS
LICENSE ON AN AS IS BASIS, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED
OR IMPLIED, INCLUDING, WITHOUT LIMITATION, WARRANTIES THAT THE COVERED
SOFTWARE IS FREE OF DEFECTS, MERCHANTABLE, FIT FOR A PARTICULAR PURPOSE
OR NON-INFRINGING. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE
OF THE COVERED SOFTWARE IS WITH YOU. SHOULD ANY COVERED SOFTWARE
PROVE DEFECTIVE IN ANY RESPECT, YOU (NOT THE INITIAL DEVELOPER OR ANY
OTHER CONTRIBUTOR) ASSUME THE COST OF ANY NECESSARY SERVICING, REPAIR
OR CORRECTION. THIS DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL PART
OF THIS LICENSE. NO USE OF ANY COVERED SOFTWARE IS AUTHORIZED HEREUNDER
EXCEPT UNDER THIS DISCLAIMER.

6. TERMINATION.

6.1. ThisLicense and the rights granted hereunder will terminate automatically if Y ou fail to comply with
terms herein and fail to cure such breach within 30 days of becoming aware of the breach. Provisions
which, by their nature, must remain in effect beyond the termination of this License shall survive.

6.2. If You assert a patent infringement claim (excluding declaratory judgment actions) against Initial
Developer or a Contributor (the Initial Developer or Contributor against whom Y ou assert such claim is
referred to as Participant) alleging that the Participant Software (meaning the Contributor Version where
the Participant is a Contributor or the Original Software where the Participant is the Initial Developer)
directly or indirectly infringes any patent, then any and all rights granted directly or indirectly to You by
such Participant, the Initial Developer (if the Initial Developer is not the Participant) and all Contributors
under Sections 2.1 and/or 2.2 of this License shall, upon 60 days notice from Participant terminate
prospectively and automatically at the expiration of such 60 day notice period, unlessif within such 60 day
period Y ou withdraw Y our claim with respect to the Participant Software against such Participant either
unilaterally or pursuant to awritten agreement with Participant.
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6.3. Inthe event of termination under Sections 6.1 or 6.2 above, al end user licensesthat have been validly
granted by You or any distributor hereunder prior to termination (excluding licenses granted to Y ou by
any distributor) shall survive termination.

7. LIMITATION OF LIABILITY. UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL
THEORY, WHETHER TORT (INCLUDING NEGLIGENCE), CONTRACT, OR OTHERWISE,
SHALL YOU, THE INITIAL DEVELOPER, ANY OTHER CONTRIBUTOR, OR ANY
DISTRIBUTOR OF COVERED SOFTWARE, OR ANY SUPPLIER OF ANY OF SUCH PARTIES, BE
LIABLETOANY PERSON FORANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR
LOST PROFITS, LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR
MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL DAMAGES OR LOSSES, EVEN IF
SUCH PARTY SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES.
THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO LIABILITY FOR DEATH OR
PERSONAL INJURY RESULTING FROM SUCH PARTYS NEGLIGENCE TO THE EXTENT
APPLICABLE LAW PROHIBITS SUCH LIMITATION. SOME JURISDICTIONS DO NOT ALLOW
THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO
THISEXCLUSION AND LIMITATION MAY NOT APPLY TO YOU.

8.U.S. GOVERNMENT END USERS. The Covered Softwareisacommercial item, asthat termisdefined
in 48 C.F.R. 2.101 (Oct. 1995), consisting of commercial computer software (as that term is defined at
48 C.F.R. 252.227-7014(a)(1)) and commercial computer software documentation as such terms are used
in 48 C.F.R. 12.212 (Sept. 1995). Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through
227.7202-4 (June 1995), all U.S. Government End Users acquire Covered Software with only those rights
set forth herein. ThisU.S. Government Rights clauseisin lieu of, and supersedes, any other FAR, DFAR,
or other clause or provision that addresses Government rightsin computer software under this License.

9. MISCELLANEOUS. ThisLicense representsthe compl ete agreement concerning subject matter hereof.
If any provision of this Licenseis held to be unenforceable, such provision shall be reformed only to the
extent necessary to make it enforceable. This License shall be governed by the law of the jurisdiction
specified in a notice contained within the Original Software (except to the extent applicable law, if any,
provides otherwise), excluding such jurisdictions conflict-of-law provisions. Any litigation relating to this
License shall be subject to the jurisdiction of the courts located in the jurisdiction and venue specified
in a notice contained within the Original Software, with the losing party responsible for costs, including,
without limitation, court costs and reasonable attorneys fees and expenses. The application of the United
Nations Convention on Contracts for the International Sale of Goods is expressly excluded. Any law or
regulation which provides that the language of a contract shall be construed against the drafter shall not
apply to this License. You agree that You alone are responsible for compliance with the United States
export administration regulations (and the export control laws and regulation of any other countries) when
Y ou use, distribute or otherwise make available any Covered Software.

10. RESPONSIBILITY FOR CLAIMS. As between Initial Developer and the Contributors, each party is
responsible for claims and damages arising, directly or indirectly, out of its utilization of rights under this
Licenseand Y ou agreeto work with Initial Developer and Contributorsto distribute such responsibility on
an equitable basis. Nothing herein isintended or shall be deemed to constitute any admission of liability.

NOTICE PURSUANT TO SECTION 9 OF THE COMMON DEVELOPMENT AND DISTRIBUTION
LICENSE (CDDL) The code released under the CDDL shall be governed by the laws of the State of
Cdlifornia (excluding conflict-of-law provisions). Any litigation relating to this License shall be subject
to the jurisdiction of the Federal Courts of the Northern District of California and the state courts of the
State of California, with venue lying in Santa Clara County, California.
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